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Cisco ® Guide 

Notification 

The BroadSoft BroadCloud has been renamed to Cisco BroadCloud.  You will begin to 
see the Cisco name and company logo, along with the new product name on the software, 
documentation, and packaging.  During this transition process, you may see both 
BroadSoft and Cisco brands and former product names.  These products meet the same 
high standards and quality that both BroadSoft and Cisco are known for in the industry. 

Copyright Notice 

Copyright© 2019 Cisco Systems, Inc. 

Trademarks 
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1 Summary of Changes 

This section describes the changes to this document for each release and document 
version. 

1.1 Changes for Release 3.9.0 

Changes for UC-One SaaS Release 3.9.0, Document Version 1 
This version of the document contains the following change: 

 Corrected release version number to 3.9.0. 

1.2 Changes for Release 3.9.1 

Changes for UC-One SaaS Release 3.9.1, Document Version 2 
This version of the document contains the following changes: 

 Updated images. 

 Removed full enterprise directory image. 

Changes for UC-One SaaS Release 3.9.1, Document Version 1 
This version of the document contains the following changes: 

 Updated images as per the new UX. 

 Updated system requirements to add Catalina and remove El Capitan. 

 Updated Hub section for O365. 

 Updated keyboard shortcuts. 

 Updated Outlook Add-in section. 

 Added new sections such as priority alert and automatic upgrade. 

 Added new features 

− Webex Meetings cross-launch 

− Webex Teams messaging with Common Identity (CI), attachments, and legacy 
mode 

− Universal search 

− Clear access code menu 

− New installer 

− S4B integration 

− Webex Teams UX 

1.3 Changes for Release 3.6.1 

Changes for UC-One SaaS Release 3.6.1, Document Version 1 
This version of the document contains the following changes: 

 Added a note about visual voice mail urgent/confidential flags support. 

 Updated system requirements to add Mojave. 
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 Updated Hub section for O365. 

 Added a note about call waiting in ringing state. 

 Added note about Outlook add-in duplicate contacts. 

 Added a note about toggling audio devices in calls. 

 Added a note about clicking installer EULA two times. 

 Added a note about managing (transfer and conference) My Room calls. 

 Modified My Room invitation link text. 

 Added a note about spell checking in US English. 

1.4 Changes for Release 3.5 

Changes for UC-One SaaS Release 3.5.0, Document Version 1 
This version of the document contains the following changes: 

 Added the following new features: 

− Alert info 

− IPv6 support (official) 

1.5 Changes for Release 3.4 

Changes for UC-One SaaS Release 3.4.0, Document Version 1 
This version of the document contains the following changes: 

 Added the following new features: 

− Screen share resolution handling 

− Privacy link 

− Callto and Tel URL schemes 

− IPv6 support (preview) 

− Directory search result enhancement 

− Suppressing message notifications when sharing 

 Added a further note about moderated My Room. 

 Added examples about multi-part search enhancements. 

 Updated system requirements to remove OS X 10.10. 

 Updated EULA for EmojiOne library. 

1.6 Changes for Release 3.3 

Changes for UC-One SaaS Release 3.3.0, Document Version 1 
This is the first version of the document and contains the following changes as compared 
to UC-One Desktop, Release 22.3: 

 Added more information on moderated My Room. 

 Added UC-One SaaS details. 



 

UC-ONE FOR DESKTOP USER GUIDE 60-BT9001-00 
©2019 CISCO SYSTEMS, INC. PAGE 11 

2 About UC-One for Desktop 

UC-One for Desktop is a native Windows or Mac client for SaaS Unified Communications, 
providing the following communication features: 

 Instant Messaging and Presence 

 Voice Calling (VoIP) 

 Voice Calling (Desk Phone) 

 Video Calling 

 Desktop Sharing 

 BroadWorks Call Settings 
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3 Get Started 

This section contains the essential information to get started with UC-One.  End users 
need to make sure they are using valid drivers for video (for example).  Additionally, make 
sure to always use the latest OS version with latest security updates. 

3.1 Installation 
Your service provider provides the download of the installer.  Only MSI installer is 
supported. 

Windows 

 Double-click the installer executable and follow the installation instructions. 

 Launch UC-One. 

OS X 

 Double-click the disk image. 

 Copy the application into the Applications folder. 

 Launch UC-One. 

3.2 Sign In 
When you first launch the application, you are prompted to sign in.  Depending on your 
service provider settings, SSO may or may not be used. 

In the legacy mode without SSO, the login flow is as follows: 

If displayed, enter the login access code provided by the service provider and move to the 
next view. 

1) Enter your BroadWorks user name and password. 

2) Select whether you would like UC-One to remember your password. 

3) Select whether you would like UC-One to sign you in automatically on subsequent 
launches. 

4) Click Sign In. 

When SSO is enabled, the login flow is typically as follows: 

If displayed, enter the login access code provided by the service provider. 

1) Click the Go to Signin Screen button in the login screen. 

2) As a result, an external web browser opens, you can also choose to use the 
Operating System (OS) browser by checking the Login view checkbox.  Provide the 
login credentials in the web browser view.  With SSO, Remember Password and Sign 
In Automatically checkboxes are not visible.  When using the Exit option, the 
password does not have to be re-entered in SSO environments in the next login 
typically whereas with Logout, the password must be re-entered. 

3) Click Next to go to UC-One. 

Depending on your service provider configuration, you may also have to enter your email 
address after the steps above when the login flow is changed to use the Common Identity 
(CI).  This applies to the first login after CI login is activated. 



 

UC-ONE FOR DESKTOP USER GUIDE 60-BT9001-00 
©2019 CISCO SYSTEMS, INC. PAGE 13 

You can also access Help, Preferences, directly from the Login window.  If needed, you 
can modify the access code by selecting the Clear Access Code menu option in the login 
window. 

NOTE:  If you choose automatic sign in in legacy mode, you are automatically signed in and 
taken to the Main window upon subsequent UC-One launches.  Otherwise, you are presented 
with the Sign In screen when launching the application.  In the Main window, your default tab 
when signing in depends on configuration; otherwise, UC-One remembers the tab you were on 
at sign out and opens that same tab at sign in. 

In legacy mode, the Login window offers the last used username, but the password shall 
be automatically filled in only if you have checked the Save password check box.  If 
multiple people use the same machine, only the last password is entered as a security 
measure.  If you change the username in the Login window through editing it, or using the 
drop-down list to pick another one, UC-One does not fill in the password; you are always 
expected to type it in.  This also applies when re-selecting or re-entering the last used 
username. 

After logging in, a pop-up dialog may appear informing you about emergency calls, and 
another about changing your location for emergency calls.  You may also see a banner in 
the Main window related to emergency calls.  Depending on your service provider settings, 
emergency calls may not be allowed.  In this case, calling an emergency number displays 
a pop-up dialog.  A notification message in the Main window may also display.  It is not a 
supported configuration to run many Desktop clients at the same time with the same 
account. 

NOTE:  It is possible to run several UC-One instances at the same time, but headphone 
connectors and Outlook integration may not work as expected. 

3.3 Main Window 
When you start UC-One for the first time, your Contacts list is empty.  Use the Search field 
to find people and add them to your Contacts list.  Contacts can also be added manually 
by clicking the Add button.  Client windows can also be set to always use the Main 
window menu option.  The dial pad is also integrated with the Main window. 

UC-One uses a tab view for new chat sessions.  The Search field allows searching for 
contacts while making calls using phone numbers is done either in the call history/dial pad 
view or via the contact list.  SIP URIs can be used in contact cards and must use the 
format user@domain or sip:user@domain.  The table that follows the following image 
describes the key icons used in the Main and Communications windows. 

 
Figure 1  Tabbed Main Window 
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Icon Usage 

 

My Information – View and update your information, for example, your presence, avatar, 
and location. 

 
Contacts – View your contacts. 

 
My Room – This is your permanent communication room.  Participants can dial in to your 
audio bridge. 

 
Call History – View previous calls. 

 
Chat History – View previous chats. 

 
Dial Pad – Make calls (it is integrated with the Main window call history view). 

 

Web Button – Provides web content inside the Main window or browser. 

 

UC-One Hub – Provides micro-apps and contextual intelligence to chat tabs. 

  

Preferences – Use for quick access to preferences and Call Settings such as Call 
Forwarding. 

 
Chat – Start an instant message conversation with a selected contact. 

 
Call – Make an IP audio call to a selected contact. 

 
Call from Phone – Make a Click To Dial call from your desk phone (or secondary device). 

 
Video Call – Make a video call to a selected client (VoIP). 

 
Share – Share either the whole screen or an individual application. 

 
Menu – Open Communications options. 

 
Add – Add a contact, group, or conference. 

 

My Information 
 Click the avatar to update your status or location and enter free text (native Desktop 

only).  Webex Teams avatars override XMPP avatars if both are available. 

 Double-click the avatar to upload a picture or use a right-click menu. 
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 Right-click the avatar to update your status via menus (native Desktop only). 

Presence 
You can set your presence to one status indicated in the following table. 

Icon What it means 

 
Automatic presence:  This is the Available status where automated presence statuses 
such as In-call override the Available status. 

 
The green presence icon indicates that you are online and ready for communication.  
This status is used until you change it and automated presence statuses such as In Call 
do not override. 

 
The yellow presence icon indicates that you are online but have been idle or away from 
your computer for more than ten minutes. 

 The red presence icon indicates that you are busy and do not want to be disturbed. 

 
The grey presence icon indicates that you are offline, and the only available contact 
method is calling or leaving a chat message. 

 
This icon indicates that the contact is busy on a call.  This is an automated presence 
status. 

 
This icon indicates that the contact is busy in a meeting.  This is an automated presence 
status.  The Busy – In Call status overrides the Busy – In Meeting status so this one is 
only seen if there is a meeting but no call. 

 

UC-One can automatically update your presence to the following: 

 Busy – Call 

 Busy – Meeting 

 Available (desk phone) 

 Available (mobile) 

 Away (mobile) 

 Offline and busy in call 

Location 
Your location is automatically determined by your public IP address; however, you can 
manually set the text to appear for your location and time zone using the location dialog 
box or prevent location from showing. 

3.4 Communications View 
After starting communication with one or more contacts, a new tab is displayed for chat.  
The call window is also integrated with the Main window chat tab by default.  You can 
separate a tab on to a different Communications window by dragging and dropping it 
outside of the Main window.  From this view, you can perform the following actions: 

 Escalate a chat to include audio, video, and desktop sharing 

 End an audio or video call 

 Open the dial pad 

 Mute your microphone 

 Adjust your speaker volume 
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 Place a call on hold 

 Transfer a call 

 Toggle between speaker and headset 

If you are using several monitors, UC-One opens the Communications window as well as 
notifications on the same monitor as the Main window where the application is located. 

UC-One limits the number of active communications to spare resources.  The limit is 20 
active communications on Windows and 30 on OS X.  If the maximum is reached, the 
main window’s top section warns user with the following message:  “The maximum 
amount of communication windows has been reached.  Please close some to open new 
ones.” 

If an incoming call is answered while this warning is shown, the client closes the chat 
session that has the longest time since its last activity. 

3.5 Start Chat 
Start a chat tab using one of the following methods: 

 Double-click or single-click a contact from the Contacts list or search results, 
depending on whether legacy mode is used or not. 

 Right-click one or more contacts from the Contacts list or search results and select the 
Chat menu. 

 On the Communications History list, double-click or single-click a chat entry 
depending on whether legacy mode is used or not. 

 In a Communications window, click the Chat button (this does not open a new tab). 

 In the Main window, click the Add button and in the resulting tab click the Chat icon. 

3.6 Send File 
 In a one-to-one chat, transfer files by clicking the Send File button in the 

Communications window or use the “drag and drop” method so that they are moved 
to the Communications window. 

3.7 Send Email 
Right-click a contact from the Contacts list or search results and select the Email menu 
option.  The contact must have an email address defined for this feature. 

3.8 Make Audio or Video Call 
Make an audio or video call using one of the following methods: 

 Right-click one or more contacts from the Contacts list or search results and select the 
Call, Call from Phone, or Video menu item. 

 Open the dial pad, enter a phone number, and then click the Call, Call from Phone, 
or Video button. 

 On the Communications History list, double-click a call entry. 

 In the Communications window, click the Call, Call from Phone, or Video button. 

 When viewing a contact’s profile, click the Call, Call from Phone, or Video button. 
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NOTE:  If dialing a phone number that requires additional dual-tone multi-frequency (DTMF) 
tones (for example, a conference bridge), you can type the numbers on your keyboard while the 
Communications window has focus or open the dial pad in the Communications window. 

3.9 Share Your Application or Desktop 
Share your desktop by following these steps: 

1) Click the Start Sharing button on the top of the Communications window (if share 
panel is not visible).  The Share button is visible by default in My Room also.  The 
share selector window opens. 

2) Select the application to share or the entire screen of a particular display and click the 
Start Sharing button. 

In addition, participants can also share. 

3.10 Active Communications 
Active communications appear at the top of the Contacts list in the Main window (native 
Desktop only).  This area provides an easy view to see the people with whom you are 
communicating.  By default, there is no separate call tab, but the call is shown in the Active 
Communications area in the Main window (where the call can be fully controlled in the 
Desktop client).  It reduces the number of Communications tabs and windows; however, a 
separate call window can still be opened using an Active Communications menu.  The 
following is also available in this area: 

 Double-click an active communication item to bring this Communications tab into 
focus (legacy mode only).  You can use a menu option to show the Communications 
window separately. 

 End a call. 

 Mute the microphone. 

 Place a call on hold. 

 Merge two calls or transfer by dragging and dropping calls onto each other. 

 Transfer a call. 

 Make conference calls. 

 Park and retrieve calls. 

You can right-click the “More” icon of an active Communications item (icon with three dots) 
for additional options while a left-click offers additional call management options for this 
call as well as other options when available. 

3.11 My Room 
My Room is an always available and permanent room you can use to chat with anyone 
that joins. 

Silent dialing is enabled, so you cannot hear any DTMF tones when dialing into My Room 
(the call is made automatically with the required conference ID). 

You can invite others to your room by dragging and dropping them from the Contacts list 
into the My Room tab.  You can also use the right-click menu on the My Room icon in the 
top-right corner of the Main window or the My Room information area to copy an invitation 
link for guest users (people without UC-One). 
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Contacts join your room by right-clicking your name on their contact list and selecting Join 
Room or by an invitation you sent. 

Email My Room Invitation menu results in working links for guest users only.  UC-One 
users are recommended to use Copy My Room Invitation links; however, the links may 
not work in all applications as they were originally intended for Outlook. 

You can also export the attendee list using the related participant menu available via the 
options icon (three dots). 

In My room calls, the owner can also see active speaker info with the Mute/Unmute icon. 

My Room also contains alternate PSTN numbers to dial in to the bridge.  The My Room 
invitation refresh button in the Meeting Info also changes the conference ID. 

My Room calls cannot be conferenced or transferred. 

3.11.1 Select Audio Devices 
If you have multiple audio devices available for your microphone or speakers, select the 
preferred audio device before starting a call. 

Windows 
1) Click the UC-One logo in the Main window title bar. 

2) Select Preferences. 

3) Select Audio. 

4) Set a playback device (speakers). 

5) Set a recording device (microphone). 

6) Click OK. 

OS X 
1) Select UC-One from the main menu. 

2) Select Preferences. 

3) Select Audio. 

4) Set a playback device (speakers). 

5) Set a recording device (microphone). 

6) Click OK. 

If “Use default” is selected, then UC-One uses the default device set in the operating 
system preferences.  For Windows, if “Default Communication Device” is defined, it is 
selected over the “Default Device”.  If you are using headsets, you can also select a 
separate device than the headset for alerting incoming calls. 

Note that on OS X, it is recommended to disable “Use ambient noise reduction” in System 
Preferences to reduce echo.  For more information on USB headset support and settings 
details, see section 7.17 Headset Support. 
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4 Contacts 

Contacts are the people with whom you communicate and, in most cases; you see their 
presence and share your presence with them.  There are three types of contacts: 

 Contacts – Actual people with whom you communicate. 

 Conferences – Audio or video conference bridges that you use to communicate with 
others.  Silent dialing into the bridge also applies to these contacts.  Conference 
contacts are regular contacts and added just like regular contacts. 

 Groups – Containers of contacts and/or conferences. 

There is no hard-coded limit on the number of contacts.  The more contacts are added the 
more memory and processing is needed.  The more contacts are added, the more difficult 
it is to find people without searching.  Live search can be used instead of a very large local 
contact list while keeping memory and processing requirements to a minimum. 

4.1 Add 
When you sign in for the first time, there are no contacts on your contact list.  Add a new 
contact at any time by selecting the Add Contact item from the menu or choose the Add 
button from the Main window (+ icon).  In the resulting tab, you can select to add a contact, 
group, or other items. 

In the Add Contact tab, enter the contact’s information and then click Save.  Your 
presence information is not shared with your new contact unless they also add you to their 
contact list.  If someone adds you to their contact list, your presence information is 
automatically shown. 

The newly added contact appears on your contact list. 

Add a conference contact by clicking the same button and tab you did for Add Contact.  A 
conference contact is a special contact used for conference bridges to avoid remembering 
PIN codes and conference number, for example, recurring conferences.  Just create a 
contact for the weekly conference, add a conference bridge number and PIN, and join the 
conference just by right-clicking the contact or choosing it and clicking the Call button. 

Choose the Add Group menu option to add a new group to the contact list. 

Contact card telephone number fields can also have SIP URIs (work, mobile, extension, 
personal, and conference bridge). 

4.2 Edit 
Edit a contact by selecting the contact first.  After you select the contact, right-click 
anywhere in the area of the selected contact and a menu of options appears which allows 
you to either view or edit the contact profile.  In View mode, click the Edit button to go to 
Edit mode.  This base principle is the same for normal contacts and groups.  You can also 
use the cloud icon for synchronizing the contact card with the directory.  To synchronize 
the contact card data, click on the cloud icon. 

 Unsubscribe removes the presence relationship between you and that contact.  This 
means you do not see the contact’s presence information, but the contact still sees 
your presence if you have been added to their contact list.  To re-establish the 
presence relationship, select Subscribe.  An unsubscribed contact remains on the 
contact list and is always shown without an icon.  Any contact that is not presence-
enabled is shown in the same way. 

 Delete contact removes the contact from your contact list. 
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 View Profile opens the Contact Information dialog box where you can add, edit, or 
remove information.  This works for both normal and conference contacts. 

 For groups, choose the Edit menu option to rename a group. 

Once done with all changes, click the Save button. 

4.3 Filters 
You can filter contacts in two ways: 

 Use the filter field to search by contact name.  The contact list is filtered in real time as 
you type. 

 Alternatively, use the filter menus available by right-clicking the Contacts icon in the 
left pane to display only specific types of contacts such online contacts (native 
Desktop only).  You can also sort contacts based on first or last name or choose 
whether to display the contact’s avatar and availability status in the contact list. 

Favorite filtering works slightly differently: 

 When you make a contact your favorite, the favorite group shows on top of the 
contact list and cannot be hidden. 

 When you delete all your favorite contacts, the favorite group does not show 
anywhere. 

 When you have even one favorite marked, you see the group. 
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5 Presence 

For each contact you have subscribed to, you can see their presence.  Similarly, your 
contacts can see your presence on their contact list. 

Presence means that your friends can see whether you are available to communicate, for 
example, “I’m busy” or “I’m available”. 

Icon What it means 

 
Set Automatically:  This is the Available status where automated presence statuses such 
as Busy In-call override the Available status. 

 
Available:  The green presence icon indicates that the user is online and ready for 
communication.  This status is used until you change it and automated presence statuses 
such as In Call do not override. 

 
Away:  The yellow presence icon indicates that the user is online but has been idle or 
away from their computer for more than ten minutes. 

 
Busy:  The red presence icon indicates that the user is busy and does not want to be 
disturbed. 

 
Offline:  The grey presence icon indicates that the user is offline, and the only available 
contact method is calling or chatting. 

 
Presence Pending icon indicates that a subscription is pending, and the contact has not 
yet approved sharing their presence.  Typically, this would not appear as buddy requests 
are automatically accepted by the server; however, you may see this in error situations. 

 
This icon indicates that the contact is busy due to a call.  This is an automated presence 
status. 

 
This icon indicates that the contact is busy due to a My Room session, either their own 
My Room or someone else’s.  This is an automated presence status.  The Busy – 
Meeting status is overridden by 1-1 calls and the resulting Busy – Call presence. 

 
This icon indicates that the contact is busy due to a meeting.  This is an automated 
presence status.  The Busy – In Call status overrides the Busy – In Meeting status so this 
one is only seen if there is a meeting but no call. 

 
This icon indicates that the contact is only available on mobile UC-One. 

 
This icon indicates that the contact is only available on a compatible desktop phone, and 
not UC-One. 

 
This icon indicates that only the mobile client is online and in the away status.   

 
This icon indicates that the user is in a call but is not logged in to XMPP (presence and 
chat). 

 

The avatar in this version is not completely in real time.  The avatars are retrieved at login, 
when the contact is added, and when the contact comes online.  Double-click the avatar to 
change your avatar.  A File Explorer view opens. 

If you see an error message at the top of the Main window “XMPP Unavailable”, it means 
that the XMPP connectivity has been lost for chat and presence; however, you can still 
make calls.  You should contact your service provider. 

Have the Outlook calendar automatically change your presence to Busy – In Meeting by 
enabling this in the Preferences → General tab (native Desktop only). 

The presence update is only triggered by appointments and meetings that are in the Show 
me as busy state. 
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The XMPP address of a contact cannot be changed.  Instead, you must delete the old 
contact and create a new one. 

Location in presence is done based on the IP address that the machine is using on 
Windows.  The IP address is mapped to a physical location.  On OS X, the operating 
system location is utilized.  You will be prompted to accept location usage.  Change the 
location manually by clicking the avatar (if presence controls are not already expanded) 
and then the location icon to go to the manual location and change the view. 

Snapshot of presence status is also available in search results and Communications 
window for contacts who are not buddies.  This presence status is not updated after the 
search is done or after the communication session is set up. 
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6 Chat 

6.1 Chat View 
Release 3.9.0 added support for Webex Teams messaging.  If you have older XMPP 
chats, they are presented in the same communications history view with Webex Teams 
chats. 

When you initiate a chat, the Chat tab inside the Main window opens.  Chatting with a 
contact is possible only when you are online.  If your contact initiates a chat, you see a 
pop-up notification in the bottom right-hand corner of the screen.  If you close the Chat tab 
and open it again, sent chat messages are shown in the tab as chat history, a typing 
notification is also shown. 

In so called legacy mode where XMPP chat is used there is a setting in Preferences → 
General view to select between single click and double click in contact list to initiate a new 
chat session.  When your service provider is using Webex Teams messaging, single click 
mode is used where clicking a contact list contact once opens a new chat session.  This 
means that to open a chat session with a contact in the contact list, you only need to 
single-click the contact list contact. 

When the chat opens, you see the contact’s information at the top of the screen. 

You can delete the history using the drop-down menu. 

In the text field, you can add a smiley emoticon.  Smiley emoticons can also be added by 
manually entering the corresponding characters that represent that specific emoticon.  
You can send text by pressing ENTER. 

The full set of Emojis is also supported and they are rendered as ordinary emoticons when 
received.  Spell checking in US English is also supported and can be disabled in 
Preferences.  For troubleshooting tips, see section 32 Troubleshooting. 

To enter a line break in the text field, you can use the following key commands: 

 CTRL+ENTER (command+enter on Mac) 

 SHIFT+ENTER 

 ALT+ENTER 

Use either one of the short commands, CTRL+C or CTRL+V, or right-click the selection 
for a menu to copy or paste the text to or from the Chat tab. 

It is also possible to chat with users in other domains.  BroadCloud also supports Google 
federation.  Group chat is not supported in Google federation, so the group chat option 
with these contacts is shown in grey. 

All sent and received chats are stored locally in the chat history and an optional message 
history feature provides multi-device enhancements so that messages sent or received in 
other own devices would also be shown. 

Webex Teams messaging is also supported together with XMPP messaging.  In terms of 
the user experience, both are very similar.  Your service provider preferences dictate 
which one is predominantly used.  Webex Teams spaces are also supported and are 
shown with other messaging sessions in the chat view.  UC-One Desktop supports both at 
the same time.  XMPP chat is only used with contacts who only have a XMPP JID and no 
Webex Teams identity.  XMPP-only contacts are indicated in the chat view with an icon.  
Webex Teams attachments (files) are also supported. 
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NOTE:  Connect group messaging sessions to Connect clients remain in read-only mode in this 
release. 

If you have older XMPP chats, they are presented in the same communications history 
view with Webex Teams chats. 

6.2 File Transfer 
File transfer functionality is only accessible through the Chat tab. 

1) To open the File Selection dialog box, click the Send File button located to the side of 
the text field. 

2) From the dialog, select the file to be sent, and then click Open.  You can also drag 
and drop a file into the Chat tab. 

3) Once the file offer is issued and during its transfer, you can cancel the transfer (at any 
time) by clicking Cancel. 

4) Accept an incoming file transfer by clicking the Accept button. 

5) Reject the file transfer offer by clicking the Decline button. 

After the file transfer has completed, the received files can be opened or viewed in the file 
manager by using the File received, click to open, and Show in folder links. 

In error situations, partially received files are not deleted automatically. 

6.3 Group Chat 
Start a group chat in My Room by “multi-selecting” and right-clicking the Main window 
contact list.  More people can be added later to the chat by “drag and drop”.  Only the 
owner can add more participants. 

A group chat works the same way as a one-to-one chat in a tabbed view.  All messages 
from anyone are sent to everyone else.  All contacts need to be online to be able to 
participate in a group chat.  You cannot invite an offline contact or a contact that is not on a 
device that supports group chat.  This does not affect the group chat in any way. 

A group chat history is saved in My Room and is available to view later in the Messages 
tab of the Main window. 

In the text field, the contacts’ names appear in different colors to easily distinguish 
between who is writing. 

Only the newest chat room messages are stored on the server.  One-to-one chat 
messages are only saved locally.  Messages sent from your other devices are also shown. 

Deleting a chat room is not supported. 

Chat rooms can be moderated by the owner in My Room.  Use the right-click menu 
options to remove a participant from your chat room.  If needed, the removed participant 
can join later.  The removal also applies to desktop share sessions. 

Typing notifications are not supported in group chats. 

There is support for receiving group messages sent from UC-One Connect but these 
sessions are in read-only mode.  Existing and received messages can be viewed but you 
are not any more able to start new group messaging threads. 
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Webex Teams spaces are used for ad-hoc group messaging.  For groups, a new space is 
used always.  Spaces are visible with one-to-one messages in the messaging view.  Note 
that some Webex Teams features are not supported in this release: 

 Assigning / removing moderators 

 Searching for Webex Spaces where the user does not participate 
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7 Audio and Video Calls 

The following table describes additional Communications window icons and explains what 
you can do with them, for voice and video calls. 

Icon What you can do 

 
Add or remove video from the call. 

 
Mute your microphone by clicking the mute icon. 

 

Put the call on hold.  Note that if you hold the call, the other party cannot “unhold”.  This 
freezes a video call to the last frame of the video feed.  In both voice and video calls, this is 
communicated to all parties by a notification appearing in the middle of the screen. 

 
Use this icon to access the Call Options menu.  In the Call Options menu, you can find 
different actions to use for a call depending on your settings. 

 
Use this icon to end the call. 

 
Use this icon to start sharing. 

 

In the Options menu, there are the following options: 

 Transfer a call to a third party. 

 Put the call on hold.  Note that if you hold the call, the other party cannot “unhold”.  
This freezes a video call to the last frame of the video feed.  In both voice and video 
calls, this is communicated to all parties by a notification appearing in the middle of the 
screen. 

 Adjust the volume bar to adjust the volume.  Dragging it all the way to the left mutes 
your speakers. 

 Toggle between the audio headset and speakers.  You must specify a different device 
for headset and speaker in Preferences to be able to use this feature. 

 Add participants to the call. 

As an alternative, in general available Feature Access Codes (FACs) for call management 
work during calls, for instance *55 for direct transfer to voice mail, but the ongoing call 
must be put on hold and a new call must be made to the FAC “number”.  Using DTMF for 
the same purpose does not work.  You can enter additional digits at any time during the 
call (for example, to insert a conference number) by using the keyboard in Active 
Communications or use the communications tab controls to open a dial pad. 

When establishing a call to a contact, you can choose several ways to call.  Right-click the 
contact you want to call and press the Call menu option and you can choose the number 
to call from a right-click menu.  There can be several phone numbers available in the 
menu.  The work phone is the default and top most number is followed by mobile and 
other numbers.  This also applies to the transfer and conference windows.  However, in 
certain cases, the transfer/conference default number can differ from other call options in 
other menus. 



 

UC-ONE FOR DESKTOP USER GUIDE 60-BT9001-00 
©2019 CISCO SYSTEMS, INC. PAGE 27 

The default call type can also be selected using accessibility menus (Calls → Dialing 
service).  This controls the default call type when using call buttons. 

Dial a number in the dial pad to make a call (native Desktop only).  Once you type your 
numbers, UC-One searches for contacts on both the local contact list and the enterprise 
directory. 

You can also call circuit-switched network numbers such as Global System for Mobile 
Communications (GSM); however, this depends on the service provider network you are 
using; there is no technical limitation. 

Choose your video size from the Preferences and the Video tab.  Your selection is used 
by default for future video calls.  The available sizes are automatically presented based on 
your camera. 

You cannot have two simultaneous calls with the same person. 

UC-One does not add video to an audio call without end-user consent.  This also applies 
to blind video call transfer cases where audio-only music on hold is used; this may result in 
the transferred call being reduced to audio. 

You may also see a secure call icon when an encrypted call is taking place. 

NOTE:  There is sleep prevention during calls. 

7.1 Call from Computer 
Select a contact from your contact list to start communication and click the desired 
communication button.  To communicate with someone who is not on your contact list, 
type a phone number in the Search field at the top of UC-One window (search or 
communicate) and make a call from search results. 

7.2 Call from Phone 
The second option to communicate in the row of communication buttons is the Call from 
Phone.  When you click this button, the desk phone instantly starts ringing and the call is 
established from your desk phone. 

When your service provider is configured to also initiate a call from computer (SIP call) to 
the same machine that initiated a call from phone, that incoming (SIP) call will be accepted 
and will alert if it does not have the same identity as the call from phone. 

For remote calls initiated using UC-One, you can also have mid-call controls such as 
hold/resume, transfer, and add participant. 

Automatic Busy – In Call presence also works with the Call from Phone feature. 

It is also possible to control calls initiated without UC-One in the Active Communications 
view.  The same mid-call controls are also available in this case.  In case of an incoming 
call, the actual answering action must happen with the other device. 
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7.3 Answer Call 
When someone is calling you, you see a pop-up notification on your screen.  You can 
choose to answer, silence the incoming call, and then open a chat session with the caller, 
reject the call, or silence the incoming call by closing the pop-up notification window.  If you 
silence the call, the ringtone is silenced but the caller does not see anything on their end.  
You can answer or reject the call after silencing it only if you have chosen the chat option.  
If you close the incoming call pop-up notification to silence an incoming call, then you do 
not have an option to answer or reject it any more.  When choosing the chat option, chat is 
only enabled after the call has been answered or rejected. 

If you reject the call, it causes the line to sound busy at the caller’s end and they know that 
you rejected the call. 

When someone is calling you with a video, you see the same pop-up notification; 
however, the options are answer with video, answer as voice only, silence and chat, 
reject, or silence (by closing the pop-up window).  If you decide to answer as voice only, 
the call is voice only. 

7.4 Priority Alert 
The Priority Alert feature is also supported depending on your service provider 
preferences.  Priority alerting/distinctive ringing allows you to provision call criteria in a web 
portal to provide a distinctive ring or call waiting alert tone when a call is received that 
meets the criteria.  The criteria may include information such as the calling line 
identification, time of day, day of week, and so on. 

7.5 Contact Name Lookup for Incoming Calls 
UC-One performs a local contact search for incoming calls.  If the number matches one of 
the contacts on the UC-One contact list, the name is shown on the incoming call screen 
along with the alert.  Both the display name and phone number are shown when available. 

If there is no match to a local contact, UC-One looks for a match in the Telephony 
Directory and other available directories, and if a match is found, the available information 
is shown for the incoming call.  If there is no match in the Telephony Directory, the display 
name is taken from the available information in the incoming call. 

Whenever you retrieve your call logs/history, UC-One does a lookup in the local contacts 
and populates the name if a match is found. 

7.6 Missed Call or Communication 
When you have one or more missed calls or other types of communications, there is a 
notification on the left-hand side of the navigation pane in the Main window.  Clicking the 
icon takes you to the missed communication in the Communications History view. 

7.7 Full Screen in Video Call 
Full screen mode can be activated by clicking the Full Screen button or by double-clicking 
anywhere on a video. 

Exiting full screen mode is done by pressing the Esc key (on both Windows and OS X) or 
by double-clicking the window.  Exiting full screen makes the video call go back to its 
original state (even if there was resizing of the window previously before going full screen). 

In a full-size window, you can see a similar Options menu at the top.  It has the same 
functionality as it does in the normal view.  When you move the mouse, the top bar and 
lower communication buttons appear on top of the video. 
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7.8 Multiparty Sessions 
You can have many participants in a call, either in a My Room or in an ad hoc multiparty 
call (n-way call).  Add more participants by dragging and dropping them on to the 
Communications window or by selecting the Conference menu item via the 
Communications window menu button.  By choosing the menu item, you can also add 
participants with just a telephone number.  In ad hoc multiparty calling each call party must 
be separately merged onto the call to be able to terminate failing calls to, for example, 
voice mail. 

In contrast to using My Room, which uses your permanent chat and collaboration rooms 
and conference bridge, you can start ad hoc multiparty sessions by either selecting 
multiple contacts on the contact list, by calling them, or by expanding a one-to-one session 
into a multiparty session by dragging and dropping a contact into the Communications 
window.  In an ad hoc session, there is no chat or share.  Voice conferencing does not use 
a bridge but instead uses the BroadWorks N-Way Calling supplementary service in a 
sequential fashion.  UC-One dials out to all participants and takes everyone off hold after 
the last attendee answers. 

7.9 Call Waiting 
You can have one active call at any one time if you receive a new incoming call and 
accept it.  The existing call is put on hold and you can change between these two calls by 
using the Hold/Unhold button. 

If Call Waiting is in the ringing state, then new incoming calls are rejected. 

7.10 Call Transfer 
Blind call transfer is available in the Communications window; choose the Transfer Call 
menu item to transfer the call to someone else (native Desktop only).  Attended call 
transfer is also available in the same window, first call someone to check if the called party 
can take the incoming call and then transfer the incoming call to the desired called party.  
You can also search for the transferred-to party. 

7.11 Visual Voice Mail 
You have Visual Voice Mail (audio) with new message indication in your client. 

The notification service allows you to receive a notification for a waiting voice mail.   

It is also possible to call voice mail from the dialer by long pressing the “1” icon in the 
dialer. 

With visual voice mail, a second tab is available, showing visual voice mails while another 
tab is used for call history.  Click on individual mails to listen to them.  Video mail is not 
supported.  The current design is that listening to the visual voice mail or marking it as 
read decreases the unread messages badge while just doing a single click does not.  
Visual voice mail view also indicates if the message is urgent or confidential. 

Missed calls are indicated by an icon in the Main window.  Missed video and audio calls 
are indicated with a different icon. 

You can see all visual voice mails in a list and play them inside the Main window. 

The following settings are needed on CommPilot portal to have Visual Voice Mail: 

 Voice messaging enabled. 

 “When message arrives, use unified messaging” option enabled. 

 “Use Phone Message Waiting Indicator” option enabled. 
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Auto-deleted voice mails are cleaned once a day. 

The voice mail counts in voice portal and UC-One are slightly different.  Voice portal 
messages can be either “New” or “Saved” whereas UC-One messages are either “New” 
or “Viewed”.  “Saved” in voice portal is the same state as “Viewed” in UC-One.  When a 
message is clicked in UC-One, it is automatically set to “Viewed” status, which is different 
to the voice portal where messages can be skipped via DTMF to keep them in “New” 
status. 

7.12 Call Park and Retrieve 
Call Park is particularly suited for shared environments where one person can answer the 
call, park it, do something else for a while and continue the call from another device or let 
somebody else continue the call (supported on native Desktop only). 

Transfer an ongoing VoIP call to a Call Park server and then retrieve it when needed.   
An ongoing call can be parked against your own number or another number (an 
extension).  Call Retrieval works in the same way, the parked call can be retrieved from 
your own number (an extension) or another number (an extension) to provide flexibility for 
who is picking up the parked call. 

A parked call is visible on your desktop in the Active Communications area so that you can 
easily retrieve it, but only for the duration of the BroadWorks Call Park announcement.  
After the announcement is over, the parked call disappears from the Active 
Communications area (since the triggering call is disconnected).  After the call disappears 
from the Active Communications area, the user must remember the extension to which 
the call has been parked to retrieve it using the Main window menu (or feature access 
code), unless the call was parked to the one’s “own” extension.  If the call is not retrieved 
after a certain time, then the server calls the parking user. 

7.13 Call Pull 
Call Pull allows you to pull an ongoing call from one of your devices to another one where 
the Call Pull feature is used (native Desktop only).  Call Pull can also be used with FACs, 
in this case, *11.  User interface support has been added to the Desktop so that an end 
user does not have to remember FACs.  There is support for the Call Pull button for Xsi 
calls as well. 

7.14 Call Recording Controls 
You can use call recording controls in this release (native Desktop only).  Depending on 
your service provider’s configuration, call recording can be initiated when a call starts or 
dynamically during a call (and start, stop, pause controls may be available).  Additionally, 
there is an audio indication that call recording is ongoing as well as a visual indication.  
Feature Access Codes can also be used to control call recording when enabled in the 
configuration. 

Recorded calls are accessed outside of UC-One; that is, you cannot view them using the 
client. 

Depending on your service settings, call recording behavior is one of the following (this 
cannot be controlled in the client but in the self-provisioning portal): 

 Always – recording indication (icon) in the Communications window as well as the 
Active Communications UI. 

 Always with pause/resume – recording indication (icon) in the Communications 
window as well as in the Active Communications UI (only pause/resume menus 
available). 
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 On demand – recording indication (icon) in the Communications window as well as 
the Active Communications UI (no stop menu available, only start and pause/resume).  
After a call is established, call recording starts on the server.  If the user presses the 
Start Recording button during the call, the call recording is stored, and the server 
keeps the recording of the whole call regardless of when the recording was started 
(except for pauses).  Otherwise, if no start recording is initiated from the user, the call 
recording is deleted from the server. 

 On demand with user-initiated start – recording indication (icon) in the 
Communications window as well as the Active Communications UI (menu options 
available for start, stop, and pause).  Call recording can be initiated at any time and 
several times during a call.  There are separate call recordings for each call recording 
startup. 

 Never – no indicators or menu options present. 

Pause/resume audio indication depends on your service provider settings.  It is 
recommended to log back in after changing the call recording mode in the self-
provisioning portal. 

7.15 Moderator Controls 
You can control the functionality available to participants if you are the owner of the 
session in My Room.  You can do the following: 

 Dismiss one or more participants.  This ends all sessions (group chat, audio, video, 
and share) when the participant is using UC-One for Desktop. 

 Mute one or more participants. 

 See active talker indication (room owner only). 

 See full audio participant list. 

To invoke the features, you can use the right-click menus, or you can click on the 
moderator control icons of a participant.  Note that most features are not available via 
icons.  To dismiss or mute all participants or lock the room, use the right-click menus 
available for your own icon at the top of the participant list. 

If you are not the owner, you can only see the XMPP (chat) participant list or the full 
participant list along with mobile participants. 

7.16 Forced Logout 
You may see a pop-up saying that you have been logged out due to another instance of 
the client logging in (native Desktop only).  This feature allows BroadWorks to track similar 
online client instances and only allow one of them to be online at the same time.  When 
BroadWorks notifies the client to log out, all connections are terminated, and the client 
returns to the login window. 

7.17 Headset Support 
You can control incoming and ongoing calls from a compatible headset.  The feature set 
supported is answer/hang up as well as mute/unmute.  Volume control operations are not 
reflected in the UC-One UI.  The following is a list of tested example devices, although 
other devices should also work: 

 Plantronics Voyager Edge UC 

 Plantronics Savi 700 series 

 Plantronics Blackwire C3xx, C4xx, C5xx, and C7xx 
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 Plantronics Calisto 620 

 Plantronics Voyager Legend UC 

 Logitech H570e Mono 

 Logitech BCC950 

 Logitech Conference Cam Connect 

 Jabra Biz 2300/2400 

 Jabra Speak 510 

 Jabra Pro 930 (wireless) 

 Sennheiser SC 230/260 

 Sennheiser SP 20 

 Sennheiser MB Pro1 UC 

For a complete list of tested devices, see the BroadSoft Partner Equipment Interoperability 
Summary available on Xchange. 

https://xchange.broadsoft.com/node/464941 

Headsets typically use an add-in of some kind to communicate with the rest of the client 
while calls are made.  Currently, installed add-ins are visible from the Preferences Add-ins 
tab. 

In addition to the standard HID Add-in developed by BroadSoft, headset vendors can 
develop their own add-ins that can replace the standard HID Add-in for all devices.  Some 
of these add-ins (for example, Jabra) cannot be used at the same time with the standard 
HID Add-in and must be disabled via Preferences in the UC-One client.  These vendor-
specific add-ins would be installed during new headset installation; however, the standard 
HID Add-in should remain in the preferences list.  If for some reason it has disappeared, 
adding the respective .dll file back to the add-in folder should make it visible again in the 
preferences.  If you want to change to another headset later on, the vendor-specific add-in 
could be disabled from preferences to again use the standard HID or some other new 
add-in by another headset provider. 

The following is the default add-in folder location (note that it is not possible to write to this 
location in all systems): 

 Windows 7/Windows 8/8.1/10:  C:\Program Files (x86)\BroadSoft\UC-One\connectors 

Uninstallation does not remove add-in DLLs.  In general, the following steps could be 
followed with third-party add-in DLLs. 

1) Make sure that both UC-One and the third-party add-in are installed. 

2) Go to UC-One → Preferences → Extensions. 

3) Enable your add-in of choice, either USB Device Add-in by BroadSoft or a USB 
headset vendor-specific one. 

4) Restart UC-One to take the changes into use. 

https://xchange.broadsoft.com/node/464941
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If you want to use several devices, bear in mind the rules for audio device auto-selection: 

1) Communicator has a list of five last selected audio devices per each audio device 
selection control in Communicator preferences.  Each audio device can exist in a list 
once at most, that is, if a device becomes selected again before four other devices 
have been selected, a duplicate item will not be created for the device in the list, but 
the existing item will be moved to the beginning of the list.  The order of items in the 
list is significant in the sense that it defines the order in which other devices become 
selected when a device is disconnected.  In a laptop for instance, the native 
microphone and speaker are one applicable device for the list of five devices.  A 
device can only end up to the list of five devices above during disconnection. 

2) The “Use default” item is never put on the list, it will serve as a fallback if none of the 
five devices on the list are available.  The end user can specify the default device and 
the default communications device. 

3) When a device is reconnected, it becomes automatically selected only if it was 
selected when it was disconnected.  Disconnecting devices that are currently not 
selected does not have any special behavior.  Information on devices disconnected 
while selected is not persisted in the database, that is, this behavior does not work 
over different user sessions. 

4) In a case with two devices involved (that is, a headset and the native 
speaker/microphone) and end users sometimes selects both, the ability to 
automatically fluctuate between built-in devices and third-party headset when plugging 
it in should be obtainable by using the OS default device selection for the in-built 
devices and then plugging in the headset. 

7.18 Team Telephony 
Team Telephony is comprised of a Team Telephony window showing the predefined 
team members and their related call states (native Desktop only).  For a ringing call, the 
only action is to pick it up. 

Each Team Telephony member can have four call states:  available, busy in call, ringing, 
and offline.  The status for a Team Telephony member is shown in the Team Telephony 
window.  When a line is ringing, you can see the caller ID in the respective lines tooltip if 
configured by your service provider.  All team members can see the full list of team 
members in the Team Telephony window.  A double-click on the team member performs 
the default action towards the contact.  You can drag and drop people from the contact list 
to the Team Telephony window or vice versa to transfer or conference calls. 

The corresponding server-side service must be provisioned and assigned by the service 
provider for the client to work.  Usual call management options are available once the call 
has been answered. 

7.19 Executive-Assistant 
The Executive-Assistant service allows an assistant to operate on behalf of an executive 
to screen calls, answer calls, and place calls as the “executive” (the caller ID is that of the 
executive) (native Desktop only).  The provisioning of the executive and assistant roles 
takes place on the server side and cannot be modified on the client. 

One assistant can have many executives and it is possible to: 

 Select the desired role when making a call using a pull-down menu in the Main 
window. 
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 Answer an incoming call on behalf of an executive and then push the call to the 
executive.  The incoming call is presented as a call to the executive.  In addition, all 
the usual call management options are available. 

 See that an incoming call is actually for the executive. 

The caller ID format is dependent on your service provider settings and cannot be 
changed on the client side. 

7.20 Auto-Answer 
There is support for auto-answering incoming SIP calls for call center scenarios.  The 
incoming call notification is identical to the usual incoming call notification. 

7.21 Web Pop 
Web pop allows you to get more information about an incoming call by clicking on the web 
pop button of the incoming call toaster.  You can also do the same for outgoing calls using 
menus. 

This opens your default web browser with a predefined URL that provides more 
information about the other party. 

This feature is not available for Team Telephony or the assistant in Executive-Assistant 
calls. 
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8 Application or Desktop Share 

To share your desktop or individual application: 

1) In the Communications tab, click the Start Share button.  This does not yet start the 
“share”. 

2) Select either to share your entire display or one of your open applications and click 
Start Sharing. 

The share widget appears to let you control share settings such as Preview that 
shows you what participants are seeing and Pause that pauses sharing. 

3) To stop sharing, click the Stop icon.  While sharing, all other communications 
mechanisms are also available except for video calling and file transfer.  Participants 
cannot hide a share without closing the Communications window.  Video call is also 
available while sharing. 

For participants without UC-One, use the separate Desktop Share Invitation link, if 
available, by right-clicking the My Room button.  Share selector is not dynamically 
updated while the selector is open and minimized applications are not available in the list 
of applications to share. 

As a participant, you can also zoom in and out during the share.  As the share owner, 
incoming message toasters are suppressed during share, but the missed message badge 
is incremented, and the incoming message sound is played when enabled. 

If you are first in a video call and then start share, your own video is not shown, but you 
can make it visible using the Main window menu in the bottom by selecting the feed of 
your choice. 

If you are using dual monitors, you can choose which monitor to share.  You can check 
the primary monitor in the operating system settings. 

You can also remove desktop share participants.  They are also removed from the group 
chat at the same time.  If needed, the removed participants can join later. 

In addition, participants can share by clicking on the Share button; however, the room 
owner can prevent this at any time.  Only one person can share at any one time in a 
session.  Only one share at a time is supported if you have sessions with many users at 
the same time.  Share passing is only supported in My Room. 

Participants do not have to take any action to accept the share invitation.  It is 
automatically accepted.  The same also applies to share passing.  That is, the owner does 
not have to take action for the participant to start sharing. 

When video and share are used at the same time, the different views cannot be resized.  
Instead, the primary view can be selected from the bottom of the window via thumbnails. 
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9 My Room 

My Room is started by clicking on the My Room icon on the top right-hand side of the 
Main window.  My Room is started automatically using your permanent chat room.  Add 
more online participants to the My Room group chat by dragging and dropping them into 
the Communications tab or the Conference menu.  Otherwise, they can join your room by 
right-clicking your name on their contact list and choosing the Join Room menu option.  
Once people have joined the chat room, they can click on the Call button of that window to 
join the conference.  The room owner can also share their desktop. 

In addition to the owner of the room, participants can also share the desktop but only the 
owner can add more participants. 

1) To see a Context menu, right-click the Options icon (three dots) on the right-hand 
side of the My Room tab in Meeting Info. 

2) Select Copy Guest Invitation to copy an invitation to the operating system clipboard.  
Paste this invitation, for instance, to a meeting invitation email to allow UC-One 
participants to join the conference in one click from, for example, Outlook, or Office 
applications.  Note that some applications may not recognize the UC-One link (btbc).  
You can also copy and open the My Room Invitation in your default email client by 
clicking the email icon next to the Copy Guest Link text in Room Info. 

The link has two parts:  one for UC-One users and another one for Guest users with 
some other client.  The invitation always contains a dial-in number and PIN for users 
who do not have UC-One.  The guest link, when available, allows anyone to join a 
desktop share session from a standard web browser and the downloaded Meet 
application. 

The My Room info area indicates the conference bridge details of your My Room with 
alternate PSTN numbers for the bridge.  You can also export the attendee list using 
the related participant menu available via the options icon (three dots). 

The Communications window also has an icon that provides the same Context menu 
previously discussed. 

The guest invitation link can be regenerated, doing this also changes the conference id for 
the bridge so meeting invitations need to be updated. 

For more information on desktop sharing, see section 8 Application or Desktop Share.  
Desktop sharing works the same way for both My Room and the ad hoc sessions. 

My Room uses your permanent chat room, permanent collaboration room, and 
conference bridge (audio or video).  My Room is the only way to use the permanent 
rooms. 

All My Room sessions start as chats but call and/or share can be added to the session 
while in progress manually by the participants or owner.  File transfer is not supported in 
My Room. 
My Room calls cannot be conferenced or transferred. 

In Preferences → General tab you can select to use an external Webex Meetings app for 
your My Room sessions.  In that case, there is no synchronization of events between  
UC-One and Webex Meetings. 
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9.1 Guest Client 
This feature is especially intended for users outside of the company, making it possible to 
join a full My Room session with the Meet application.  Generate separate invitations for 
guest users using My Room right-click menu items as described in the previous section.  
My Room invitations are generated using separate menu items and are intended for  
UC-One users. 

The invitations persist until reset via a separate menu item or the refresh icon. Not doing 
this in a predefined period of time results in the invitation becoming obsolete and guests 
not being able to use the link to join.  For more information, see section 7.15 Moderator 
Controls. 

After dismissing a guest user from share and chat, the audio/video portion can remain. 

The following OS and browser combinations are supported to download and launch the 
Meet application: 

 Latest Chrome on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1 
[Classic]) and OS X (10.8 and 10.9) 

 Internet Explorer 11 on Windows (Windows 7, Windows 8 [Classic], and Windows 8.1 
[Classic]) 

 Safari 7 on OS X (10.8 and 10.9.) 

For more information on guest client usage, see Appendix B:  Guest Client Usage. 
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10 Universal Search 

UC-One supports a universal search of the enterprise directory, personal directory, 
enterprise common directory, and group common directory as well as Webex Teams 
spaces and messages, calls, and files.  This takes place in the same Search field that is 
used for both a local and presence-enabled contact list search, the results are separated 
onto their own tabs: 

 Messages 

 Spaces 

 Contacts 

 Calls 

 Files 

The various directories have different purposes with the enterprise directory having the 
most data, and not all directories may be used in all deployments.  All search results are 
combined into one common set of results. 

Personal directory, enterprise common, and group common directories cannot be 
modified from the client side.  Only read access is provided.  A snapshot of the presence 
status of the contact in the results list is shown, but this presence is not updated after the 
search operation. 

Personal directory provides your own special contacts that are not in the enterprise 
directory, for instance, partner company’s numbers while group common contains, for 
example, the group’s contacts such as favorite pizza taxi. 

UC-One automatically searches the local contacts and presence-enabled contact list in 
addition to the enterprise and other directories at the same time.  As soon as there are 
results from the enterprise and other directories, these results are shown on a separate list 
in the Main window.  Additionally, there may be other search result groups from other 
search sources such as LDAP or Outlook (native Desktop only). 

In search, UC-One also supports Hiragana characters. 

Search results are displayed differently depending on the results of the contact list and 
directory search: 

 If Outlook search is enabled, there are more result groups. 

 If there are no results for a certain search source (for example, local contacts, 
Outlook, or BroadWorks Telephony Directory), then that group is different in the UI. 

The enterprise directory searches all available fields for the search string.  By default, it 
waits for 1.5 seconds before it sends the search request to the server to minimize 
unnecessary load on the server. 
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Release 3.4.0 added support for department and title in directory search results as well as 
multi-part search string enhancements depending on service provider configuration on the 
server side.  The server will apply the AND operation for each search string part.  In 
addition, the order in which the individual parts are provided will not impact the search 
result.  The enhancement applies all Xsi directories (enterprise directory, personal 
directory, group common, and enterprise common).  For example: 

 While looking for Philip Moorefield the following search string can be used:  “Phil 
Moore”.  An exact match of the first name is no longer required. 

 Looking for Joe Gold and using “jo go” or “go jo” as a search string will provide the 
same results. 

 If Gregory Evermoore has for instance an email address 
“gevermoore@company.com”, Gregory can be found using “ge” as the search string. 

There is support for showing phone number in the search results to better distinguish 
similar search results.  In addition, ToolTips are provided for search results. 

Typically, when adding a contact using directory search results, there are phone numbers 
and first names in addition to last names available.  In addition, the Extensible Messaging 
and Presence Protocol (XMPP) address and other fields are imported when found to allow 
presence and chat. 

The search results may look different for virtual subscribers such as call centers or hunt 
groups.  Searching done on email and IM&P address fields is done using wild cards in this 
release so more results may be available. 

Outlook integration (search and calendar integration) on Windows requires one of the 
following versions installed on the desktop: 

 Outlook 2010 

 Outlook 2013 

 Outlook 2016 

Outlook search also works when several Outlook accounts are in use, but only one 
account is used at a time (default selected, which can be changed in Outlook).  
Additionally, other related considerations are as follows: 

 The client searches for contacts and calendar entries in the default Outlook account.  
The account is set to the default via File → Info (left pane) → Account Settings → 
Account Settings → Data Files.  Select an account and mark it as “Set as Default”.  
After making this change, sign out and sign back in to the client and it now searches 
that account for contacts and calendar entries. 

 The client searches the Outlook contacts only on the local machine (that is, the 
Outlook Address Book).  There is no Exchange server lookup performed.  In addition, 
all directories in Outlook are searched for contacts, even deleted folders.  The 
Contacts directory can also have multiple levels of subfolders. 

Every minute, UC-One reads Outlook appointments.  If there is an appointment running at 
the current time, then the presence is shown as Busy – In Meeting.  Overlapping 
appointments are also handled.  Following are some examples of UC-One operation with 
Outlook when time is 9:10 A.M. 

 There is meeting “A” 9 A.M. through 10 A.M.  Presence is shown as Busy – In 
Meeting. 

 Presence is explicitly changed to Available at 9:15 A.M.  Presence is shown as 
Available. 
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 In the next minute, UC-One again reads the appointments and sees that “A” meeting 
is running; however, the presence was already explicitly marked as Available and 
presence is not shown as Busy – In Meeting but Available. 

 There is an overlapping meeting “B” 9:30 A.M. through 10:30 A.M.  Presence is 
shown as Busy – In Meeting when the time is 9:30 A.M. 

When deleting a meeting that is currently ongoing in Outlook, the presence status remains 
as Busy – In Meeting until the next time Outlook appointments are checked (once every 
minute) and after that, presence is shown as Available.  This change may be 
instantaneous, or it may take a minute depending on how close the timer is to being 
triggered. 

The Outlook Object Security model was introduced in Outlook 2007; however, it is no 
longer supported in UC-One.  For Outlook versions prior to 2007, the Allow/Deny pop-up 
window seen in previous releases should not be triggered.  However, those versions are 
not officially supported.  For Outlook 2013, the behavior should be similar to 2010, 
meaning the pop-up should not come up with Outlook 2010 and 2013. 

The presence update is only triggered by appointments and meetings that are either 
accepted by the user or made by them.  All day meetings do not trigger a presence 
change to Busy – In Meeting. 
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11 Call History 

The second icon from the top in the Main window on the left-hand side of the navigation 
pane displays your messaging history while the forth provides the call history.  Call history 
view is divided into three tabs: 

 Recent Calls 

 Visual voice mail 

 Dial pad, which is also by default shown on the right-hand side when entering the call 
history view 

Clicking a visual voice mail downloads the message so you can play it. 

UC-One saves a call history for placed, received, and missed calls.  The call history 
makes it easy for you to redial and call back when you have missed a call or when you 
want to easily dial a contact with whom you have recently spoken.  Each call has a 
separate entry in the list. 

Chat history for group chats, both in My Room and in instant group chat, are stored locally 
on the Desktop client, just like in one-to-one chat, but only for the time the user is joined 
into the session.  Look at individual chats by double-clicking the contact in the contact list 
or click the chat history icon in the left pane. 

Double-click on a name in the list to call back directly (this calls back the same way you 
previously spoke, for example, if you were in a video call, double-clicking starts a new 
video call).  Double-clicking an incoming call item in the Calls tab makes a call. 

To clear the missed chat indicator, you must open the missed chat. 

The Call History missed calls badges can be cleared by using the right-click menu from 
the Call History button on the left pane (native Desktop only).  The menu provides options 
to mark “Mark all as viewed”, “Mark voicemails as viewed”, and “Mark calls as viewed”. 

Release 3.5.0 added support for synchronizing the history items with available directories 
so that the display name shown is as accurate as possible. 
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12 Click-to-Call (Highlight Text) 

UC-One for Desktop supports Click-to-Call using highlighted text and global keyboard 
shortcuts.  Users can highlight text anywhere in the desktop machine to make a call and 
define the default call type used for making the call using the shortcut defined in 
Preferences.  On OS X, you must define the shortcuts on your own using the instructions 
provided in Preferences.  The order in which key combinations are pressed may be 
significant in some cases if the operating system has reserved some key combinations for 
other purposes. 
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13 Callto and Tel URL Schemes 

You can use Communicator for making calls using Callto and Tel URL links anywhere on 
your machine, but you need to register Communicator as the primary application for that 
purpose in the operating system.  Additionally, depending on your service provider 
settings, other URL schemes may also work. 

At first login on Windows, there is a dialog that asks if you want Communicator to be the 
primary calling application for Callto and Tel URL schemes.  Answering yes will modify 
Windows settings so that the next call using those links will use Communicator.  If another 
application should afterwards take precedence in Windows settings, you can again make 
Communicator the primary calling application from Preferences → Outgoing Calls tab. 

On Mac OS, you must make the same selection in FaceTime preferences.  You must log 
in with your Apple ID to be able to change the settings. 
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14 Web Button 

As a service provider option for integrating third-party web content onto UC-One Desktop, 
a left pane icon may be visible.  When clicked, it opens predefined content either in the 
Main window or on a separate web browser.  Both single and multiple links may be 
present. 

In addition, local applications can be used in the links, for instance, email.  This depends 
on your service provider configuration. 

Cookies are supported.  The saved cookies are stored in cookies.dat that can be 
accessed from Preferences → General tab by clicking on the Open folder button and 
navigating one directory level up.  To remove old cookies, first exit UC-One, then remove 
the file and sign back in.  Failing to exit the client will result in recreating the cookies.dat 
with the cookies from memory. 

There is support for opening web content onto a tab as well. 
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15 Outlook Add-in 

15.1 Introduction 
The Outlook Add-in for UC-One provides integration between UC-One Desktop and 
Microsoft Outlook. 

With this add-in, you can have Microsoft Outlook display UC-One contact presence and 
invoke UC-One functions like chat, call from computer, call from phone, and video call 
from within Outlook. 

Presence comes from UC-One or S4B, when S4B is enabled presence comes from there 
by default but your service provider can override this.  Additionally, chat and SIP calls are 
done with UC-One. 

15.2 Supported Platforms 
The following platforms are supported: 

 Microsoft Outlook 2010 (32 and 64-bit), Microsoft Outlook 2013 (32 and 64-bit), 
Microsoft Outlook 2016 (32 and 64-bit), and Outlook Office 365 

 Microsoft Windows 7 SP1, Microsoft Windows 8, Microsoft Windows 8.1, and 
Microsoft Windows 10 

 UC-One Release 3.9.0. or higher 

NOTE:  Administrator rights are required for the Outlook Add-in. 

The following language and locale combinations are supported in the installer and the 
add-in: 

 Chinese (Simplified) 

 English 

 French 

 French (Canada) 

 German 

 Italian 

 Japanese 

 Korean 

 Spanish 

 Spanish (CALA) 

 Portuguese (European) 

 Dutch 

The following third-party components must be installed for the add-in to function correctly: 

 Microsoft .NET Framework 4.7.2 Client Profile 
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These components are downloaded and installed by the installer if they are not found.  
They should not be uninstalled, as the add-in cannot functional correctly.  In addition, for 
Outlook 2016 and the Outlook Add-in (OL2016 Add-in), there are further considerations as 
follows: 

 The Outlook Add-in can only be installed by an administrator. 

 If an administrator installs for all users and a normal user starts using the OL2016 
Add-in, UC-One needs to start before Outlook. 

 For logging to work normally, UC-One needs to start before Outlook. 

 Every logging level change requires a restart of both UC-One and Outlook for 
changes to take effect.  This should be quite rarely needed. 

 If Outlook is closed while UC-One is running, UC-One needs to be restarted as well 
for the Outlook UI to behave as expected. 

 UC-One lists connected components as extensions, if connected is NO or if 
component version number is something other than 10.2.1.29, or both presence GW 
and add-in are not listed, an error has occurred.  Component is visible under Options 
→ Add-ins → UI, which displays registered and working add-ins on top, below 
stopped or non-working ones. 

 If both are listed and show connected is YES, but the Outlook UI does not work, 
restart both apps. 

 For Outlook upgrade requirements, see section 15.5 Installation. 

 For Outlook 2010, all contacts must be updated to have a SIP address.  For Outlook 
2013/2016, the following applies: 

1) The SIP address does not need to be entered for the contacts, as long as there is 
an email address that matches the Outlook contact.  The same value is looked for 
in the SIP address field, but it is probably more practical to have it in the email 
address. 

2) The Outlook Add-in allows you to choose which number to call. 

3) Two Outlook or Communicator contacts cannot have the same email address or 
IM address; otherwise, full functionality cannot be guaranteed. 

NOTE:  UC-One must be installed with administrator privileges in C:\Program Files OR the 
C:\Program Files (x86) folder. 

15.3 Log Files 
Log files for the Add-in are in the UC-One log directory.  You can open the folder via 
Preferences → Advanced by clicking on the Show logs button.  Outlook Add-in logging is 
turned on when UC-One logging is enabled. 

15.4 Windows Registry Entries 
The following table lists all the registry entries added or modified by the installer. 

Path Key Comment 

HKEY_CURRENT_USER\Software\
BroadSoft\Communicator\OutlookPl
ugin\olwnd 

wnd Keeps Outlook applications window 
reference. 
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Path Key Comment 

HKEY_CURRENT_USER\Software\
BroadSoft\OutlookPlugin 

LoggingLevel Logging level for Outlook plugin 
components.  Its value as per UC-One 
Options → Advanced logging 
selection as follows: 
Basic logging on:  0x00000003 
Detailed logging on:  0x00000005 
Both off:  0x00000000 

HKEY_CURRENT_USER\Software\
BroadSoft\InstalledBrandedBTBC 
Can also exist in 
HKEY_LOCAL_MACHINE (even 
under Wow6432Node). 

Example, 
OutlookPluginPath, 
CompanyName, 
ProductName 

These keys affect where the plugin is 
searched for when starting and where 
log files are written. 

HKEY_LOCAL_MACHINE\Software
\Microsoft\Office\Outlook\Addins\Co
mmunicator Add-in for Outlook 

LoadBehavior 0x00000003, based on this value 
Outlook loads the add-in dll. 

HKEY_LOCAL_MACHINE\Software
\Microsoft\Office\Outlook\Addins\Co
mmunicator Add-in for Outlook 

Description UC-One Add-in for Outlook. 

HKEY_LOCAL_MACHINE\Software
\Microsoft\Office\Outlook\Addins\Co
mmunicator Add-in for Outlook 

FriendlyName UC-One Add-in. 

HKEY_LOCAL_MACHINE\Software
\Microsoft\Office\Outlook\Addins\Co
mmunicator Add-in for Outlook 

Manifest $INSTDIR\plugins\Outlook$nOutlookB
itness\UC-Outlook-
addin.vsto|vstolocal 

HKEY_CURRENT_USER\Software\
IM Providers 

DefaultIMApp UC-One 

HKEY_CURRENT_USER\Software\
IM Providers\Communicator 

UpAndRunning 0x00000002 

HKEY_LOCAL_MACHINE\SOFTW
ARE\IM Providers\Communicator 

FriendlyName BroadsoftIMApp 

HKEY_LOCAL_MACHINE\SOFTW
ARE\IM Providers\Communicator 

GUID {E3D1613A-93B2-4237-B4B8-
B50595462C25} 

HKEY_LOCAL_MACHINE\SOFTW
ARE\IM Providers\Communicator 

ProcessName presencegw 

HKCU\Software\IM 
Providers\DefaultIMApp 

UC-One 
Application name 

Needs to be taken by UC-One to be 
able to call, for example, call PSTN 
numbers from Outlook. 

 

15.5 Installation 
The Outlook Add-in installation is integrated with the UC-One installation.  There is a 
check box in the installer to enable the Outlook Add-in installation.  If Outlook is upgraded, 
the Outlook Add-in must be re-installed, since the Add-in uses different files depending on 
the Outlook version. 

The Outlook Add-in installation requires administrator rights to the computer for all Outlook 
versions. 
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15.6 Features 

15.6.1 Presence in Outlook 
The Outlook Add-in displays the presence of a contact in Outlook.  Presence information 
is retrieved from UC-One and is displayed as an icon next to the contact in emails and 
calendar appointments.  The following is an example of an email with the To, From, and 
Cc fields showing presence for various contacts. 

 
Figure 2  Presence Displayed in Outlook 2010 

A contact’s presence can be Available, Away, Busy, or Offline as shown in the following 
figure. 

 
Figure 3  Presence Values in Outlook 2010 

NOTE:  You must be signed in to UC-One for the presence to be displayed.  Additionally, 
presence is only shown for contacts that have a valid SIP/IM address and are in your contacts 
list in UC-One. 
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15.6.2 Contact Actions in Outlook 
In the view of an email in your Inbox, you can see buttons allowing you to call or chat with 
the sender using UC-One.  You have the option to Chat, Call, or Video Call as shown in 
the following figure.  Call from Phone (from Computer) is available in a submenu of the 
calling button as the buttons are provided natively by Outlook.  The placement of the 
buttons differs between Outlook versions, this section provides some example images.  
Previous versions of this document provide more Outlook 2010 examples. 

 
Figure 4  Contact Options in Outlook 2013. 

NOTE:  Some of these options may not be available for all contacts.  The chat option is only 
applicable to contacts that are in UC-One.  Call options are applicable to all contacts. 

These contact actions are also available on a contact card as shown in the following 
figure. 

 
Figure 5  Outlook Contact Card in Office 365 
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15.6.3 Call Multiple Phone Numbers Configured for UC-One / Non-UC-One Contacts 
You can call any of the multiple phone numbers present in the Outlook contact card.  This 
feature is available from received mail context menu, flagged mail context menu, and 
Contact’s context menu.  You can also call the selected phone number via Call, Call from 
Phone, and Video Call. 

However, you cannot call multiple numbers for contacts stored on the UC-One client or 
contacts in LDAP (AD) directories; only numbers stored in Outlook. 

See the following figure for an example of how to make the call from a contact card. 

 
Figure 6  Contact Card with Multiple Numbers in Outlook 2016 

See the following figure for an example of how to make the call from the contact item 
context menu. 

 
Figure 7  Email Item Context Menu in Outlook 2016 

15.7 Uninstall Outlook Add-in for UC-One 
Uninstallation is done together with uninstallation of UC-One.  Also, the Outlook Add-in 
DLLs are removed, except with automatic upgrade. 
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15.8 End-User Configuration 

15.8.1 SIP/IM Address in Microsoft Outlook Contacts 

NOTE:  This section is only applicable if you use Microsoft Exchange with Outlook.  You do not 
need to configure the SIP address for SMTP-based accounts (for example, Google Mail). 

For the Outlook Add-in to integrate with UC-One, you must set a SIP or IM address for 
each contact.  The SIP/IM address for a contact in Outlook must match the SIP URI, 
Instant Messaging and Presence (IM&P) address, or Email field in UC-One.  This is 
usually done by your Microsoft Exchange or Active Directory administrator. 

You can check if a SIP or IM address has been configured for contacts by looking at the 
Outlook profile for a contact.  In Outlook 2010, open a contact card and then click on the 
View more options button. 

 
Figure 8  Outlook 2016 Contact Profile – View Profile Menu 
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Then select the Email Addresses tab.  It should have a SIP address (Outlook 2010), email 
address, or IM address in the list as shown in the following figure. 

 
Figure 9  Addresses for Outlook 2013 Contact 

In Outlook 2010, if the SIP address is missing, you can try to update the Address Book 
from the server as shown in the following figure. 

 
Figure 10  Download Address Book in Outlook 2010 

Additionally, when adding contacts from Outlook to UC-One, the IM address field can be 
populated in Outlook so that the presence feature can work directly on the UC-One side 
as the information is imported to the UC-One contact card. 
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16 UC-One Add-In for Microsoft Skype for Business 

UC-One for Desktop supports integrating with Microsoft Skype for Business (S4B) (native 
Desktop only).  The intended main use case is using UC-One for non-S4B calls such as 
calls to mobile while presence, chat, and S4B-to-S4B calls still take place via S4B 
although full Communicator functionality can also be used.  A custom menu is available on 
the S4B side used to make PSTN calls. 

Existing S4B integration with, for example, SharePoint, Office 365, and Internet Explorer 
can be used so that calls can be made from those applications. 

Usual UC-One Call Control features such as hang up, mute, transfer, conference, and Call 
Park are supported.  Communicator call logs and call settings are also available in this 
configuration. 

Communicator also updates phone presence on the S4B side.  If USB headsets are used, 
the BroadSoft Standard HID Add-in cannot be used at the same time when S4B is running 
but the standard HID will be automatically disabled.  A vendor-specific add-in can be used 
instead. 

Release 3.6.0 added support by automatically closing the Communicator window after a 
PSTN call has been completed (when enabled by your service provider). 

For detailed calling examples, see Appendix C:  Skype for Business Integration.  For a 
general overview of this feature, see the UC-One Add-in for Microsoft S4B Product Guide. 

The very first S4B integration installation requires administration rights as some Windows 
registry items need to be modified to have the dial pad visible in S4B side and to make the 
calling submenu available on S4B side. 



 

UC-ONE FOR DESKTOP USER GUIDE 60-BT9001-00 
©2019 CISCO SYSTEMS, INC. PAGE 54 

17 Emergency Calls 

Depending on your service provider configuration, several options are available for 
emergency calls: 

 Emergency Call Address Change Service (ECACS) is enabled. 

 Emergency calls are disabled. 

 Banner used for conveying your emergency call location. 

 Login dialog shown at login to inform you about your service provider’s emergency 
call procedures. 

17.1 Emergency Call Address Change Service 
Depending on service provider settings, a special dialog can be shown at login, asking if 
the (physical) address needs to be updated (native Desktop only).  If not, login proceeds 
normally.  If the user replies “yes”, a web browser opens with the possibility to update the 
physical address for emergency calls.  Once the address update is complete, login 
continues. 

Depending on service provider settings, a separate ECACS menu item may also be 
visible in the Main window.  This menu item allows ECACS to be invoked at any time after 
login. 
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18 UC-One Hub 

18.1 Introduction 
UC-One Desktop supports UC-One Hub.  It allows you to be more efficient and productive 
using various integrations with other applications such as: 

 Google:  Mail, Calendar, Drive, Tasks 

 Office365:  Mail, Drive, OneDrive, O365Tasks 

 Outlook mail and calendar 

 Box 

 Concur 

 Twitter 

 Team-One 

 Salesforce 

You can use these applications without leaving UC-One to avoid scattered 
communications and fragmented workflows.  A contextual gadget is available on the right-
hand side of the Desktop Main window to provide you with a timeline of communications, 
emails, accessed attachments and files, locations, tasks, and meetings you have had with 
a particular contact, providing you with an aggregated view on notifications and 
interactions across various applications.  You can also filter information stored in various 
applications based on context such as people, topic, and information type. 

In the Desktop Main window, you can also view integrated applications such as Google 
Drive or Concur.  See the following figure for an example.  Contacts are in the left, real-
time communications in the middle, and application integration on the right.  The icons for 
enabled integrated applications are in the Hub banner at the bottom left-hand side.  
Clicking on one of the application icons opens data from that application onto the Main 
window in place of the contact list. 

BroadSearch is available for all apps to search for content inside that app. 

Before you start using UC-One Hub, you must select your applications: 

 Click the UC-One Hub button to access the UC-One Hub service. 

 Select applications for the micro-app view and the contextual pane from Settings. 

 Upon first login, all applications will be disabled. 

To authorize, enable, and configure an application: 

1) Click on the slider next to an application.  A browser window opens asking for the 
user’s application credentials (for example, Gmail). 

2) Authorize UC-One Hub to link to the selected application. 

3) Contextual information (Call Information check box) and notifications (Notifications 
check box) are selected by default. 

4) Hovering over an application in Settings shows your email address followed by a 
Logout link and the Notifications check box. 

5) You can enable/disable notifications by checking/unchecking the Notifications check 
box. 
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6) Once notifications for an application are enabled, an application icon and a notification 
count appear at the bottom of the Main window. 

18.2 Hub Banner (Micro-app) View 
UC-One Hub banner in the Main window provides quick access to favorite applications, 
such as Gmail, Google Calendar, Google Drive, Twitter, and so on.  You can take quick 
actions on these applications directly from UC-One Hub’s banner view.  Each micro-app in 
the banner is enabled by a centralized authentication process described in the previous 
section. 

Each enabled micro-app is auto-refreshed with a built-in notification mechanism that 
keeps track of updates such as new emails, upcoming calendar events, and so on, so that 
you always have the most up-to-date information. 

Some example applications are listed in the following subsections. 

18.2.1 Google Calendar 
Displays upcoming calendar events: 

 Today 

 This Week 

Quick Actions are available when hovering over a calendar entry, including: 

 Accept 

 Decline 

 Tentative 

 Launch in browser (actual Google Calendar) 

The Notification counter shows the number of upcoming events in 30 minutes. 

18.2.2 Gmail 
Displays email filters based on: 

 All 

 Archived 

 Unread 

 Today 

 Inbox 

Quick Actions are available when hovering over an email.  The following quick actions are 
supported: 

 Mark As Read 

 Delete Email 

 Archive 

 Launch in browser (actual Google Gmail) 

The Notification counter shows the unread emails counter. 
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18.2.3 Google Drive 
Displays Google Drive’s Recent, Unread, and Shared with Me files. 

Quick Actions include “Launch in Browser”. 

The Notification counter indicates unviewed files. 

18.2.4 Google Tasks 
Displays your tasks. 

18.2.5 Box 
Displays, for example, access to your Box folders. 

18.2.6 Concur 
Displays your pending and approved Concur reports. 

Quick Actions are available by hovering over a report on the list, including: 

 Launch report in browser 

18.2.7 Microsoft O365 Mail 
Displays email filters based on: 

 All 

 Archived 

 Unread 

 Today 

 Inbox 

Quick Actions are available when hovering over an email.  The following quick actions are 
supported: 

 Mark As Read 

 Delete Email 

 Archive 

 Launch in browser (actual Google Gmail) 

The Notification counter shows the unread emails counter. 

18.2.8 Microsoft O365 Calendar 
Displays upcoming calendar events: 

 Today 

 This Week 

The following Quick Actions are available: 

 Cancel event 

 Open in actual O365 Calendar 

The Notification counter shows the number of upcoming events in 30 minutes. 
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18.2.9 Microsoft O365 OneDrive 
Displays OneDrive All, Recent, or Shared with me files.  Quick Actions include “Share” 
and “Open in OneDrive”. 

18.2.10 Microsoft O365 Tasks 
Displays your tasks. 

18.2.11 Microsoft Outlook Calendar  
Displays the same items as O365 calendar. 

18.2.12 Microsoft Outlook Mail 
Displays the same items as O365 mail. 

18.2.13 Twitter 
Displays filters for your Twitter home view, My Tweets, Retweets, and Mentions. 

Quick Actions are available by hovering over a tweet on the list, including: 

 Retweet 

 Favorite 

 Launch in browser 

18.3 Contextual Gadget 
Contextual intelligence helps find and filter relevant information to enhance your 
productivity. 

The contextual pane appears in collapsed form on the right side of the main window when 
a chat tab is opened.  The pane is dynamic showing server-side content and changes 
based on the remote user and any mutually shared information. 

For example, you are in a UC-One Hub chat with remote user B, and you can see in the 
contextual pane information shared between both users such as emails, files in Cloud 
storage, and so on. 

The BroadSearch engine is available for all apps, providing instant refinement of 
information shared with a remote user; it instantaneously executes its algorithm based on 
every character entered in the search field.  For example, with Gmail, it searches the 
emails matching the search string. 

It also inherits the search string and performs an auto-search when applications are 
switched. 

18.3.1 Gmail 
Shows recently shared emails and attachments between the user and a remote user in 
communication.  Emails can be viewed from the Emails or Attachments filters. 

Provides same quick actions when hovering over an email as in micro-app: 

 Mark As Read 

 Archive 

 Delete Email 

 Launch in browser (actual Google Gmail) 
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18.3.2 Gmail and Google Drive Files 
Google Drive and Gmail attachments are filtered in respective tabs.  The Drive tab lists 
Google Drive files shared between you and the remote user.  The Gmail tab shows Gmail 
attachments shared between you and the remote user. 

18.3.3 Twitter 
Twitter feeds are listed under the Social filter, showing recent tweets of the remote user.  
The mechanism of fetching a remote user’s Twitter handler is based on the Google 
Contacts custom field. 

18.3.4 Google Calendar 
A filter with upcoming meetings is provided.  Additionally, it is possible to schedule a 
meeting. 

Same Quick Actions are available as in the micro-app: 

 Accept 

 Decline 

 Tentative 

 Launch in browser (actual Google Calendar) 
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19 Forced Configuration Update 

Depending on your service provider configuration, forced configuration update can be 
supported.  When enabled, you will be prompted to log in again when the configuration 
has changed.  However, this will not happen if you have ongoing calls, share, or group 
chat sessions. 
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20 Password Change 

A dialog box automatically opens when your login password must be changed (native 
Desktop only).  You must provide the password two times for verification purposes.  Using 
a menu in either the bottom right-hand corner or the top of the Main window, your 
password can be changed at any time. 
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21 Accessibility Compliance 

UC-One supports accessibility compliance by having all client features available in menus 
at the top of the Main window (native Desktop only).  The menu items are also available 
using the keyboard shortcuts listed in Appendix A. 

UC-One has support for the following features: 

 Dictation 

 Screen reader (VoiceOver on OS X) 

 Keyboard navigation 

The following limitations apply: 

 On OS X by default, the tab key moves the focus between text-inputs and lists.  This 
can be changed through System Preferences → Keyboard → Shortcuts.  Under Full 
Keyboard Access, select “All Controls” instead of “Text boxes and lists only”. 

 Dictation on OS X:  If WebRoot SecureAnywhere is used, the Pause Secure 
Keyboard Entry must be selected. 

 Users must manually select the correct language in screen reader.  UC-One does not 
force screen reader's language according to the language selection in the client. 

 On OS X, the VoiceOver focus follows the VoiceOver Cursor.  When VoiceOver is 
enabled, users are expected to navigate with the VoiceOver Cursor.  That can be 
enabled through System Preferences → Accessibility → VoiceOver → Open 
VoiceOver Utility.  In the opened window, open “Navigation” and check “Keyboard 
focus follows VoiceOver cursor”. 

 When using VoiceOver on OS X with different languages, the OS language, client 
language, and VoiceOver language all need to be the same. 

Recommended Preferences → General → Accessibility settings for screen 
reader/VoiceOver are: 

 ToolTips disabled 

 Pop-up errors enabled 
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22 Google Analytics 

UC-One can send analytics data to Cisco (formerly BroadSoft) to improve the service.  
You can enable and disable this option in Preferences. 
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23 IPv6 Support 

Release 22.4.0 added support for IPv6 as a preview feature and Release 22.5.0 as an 
official feature.  IPv6 usage depends on your network service provider. 
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24 Preferences 

Preferences provide access to available settings for UC-One.  Follow these steps to 
access Preferences. 

Windows and OS X 
1) Click the Preferences logo in the Main window left pane. 

2) Select the desired view from the drop-down. 

or 

Windows and OS X 
1) Go to the UC-One accessibility menu. 

2) Select Preferences. 

3) Select the desired view from the drop-down. 

24.1 General 

Language 
Select your language then click OK or Apply and the change takes effect immediately. 

Login 
Enable or disable automatic login when starting the application and control the remember 
password feature as well as enable the Update Password feature. 

Notifications 
Usually there is a confirmation pop-up notification each time you remove a contact or chat 
history record.  By selecting one or all of the check boxes, you can disable the 
confirmations when deleting information.  You can also control whether there is always a 
pop-up notification for publishing location information.  Typically, this is shown at login.  
You can also select whether to receive a notification before ending communication or 
holding a call. 

Accessibility 
Enable pop-up errors allows UC-One error pop-ups to be shown in addition to the usual 
error text shown at the top of the Main window. 

Enable ToolTips is enabled by default.  For accessibility, screen reader/VoiceOver reads 
all ToolTips, which may be frequent and hence disturbing.  For this reason, in accessibility 
cases, it is recommended to disable ToolTips. 

You can also enable spell checking and auto-capitalization. 

24.2 Audio/Video 

24.2.1 Audio 

Headset 
Here you can specify the output and input devices used for the headset when toggling 
between the headset and speakers. 
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Note that in order to be able to toggle between headset and speakers during calls, you 
must specify a different device for each.  Using default for both will result in the same 
device being assigned to both so toggling will not work. 

Output Device (Voice Playback) 
Choose a headset, PC-integrated speakers, or external speakers for audio output.  Your 
external playback device is selected by default (if you have one connected). 

Input Device (Voice Recording) 
Choose a headset microphone, PC-integrated microphone, or external microphone for 
voice during calls.  Your external recording device is selected by default (if you have one 
connected).  You can also choose automatic gain control and test your recording device. 

Speakers 

Here you can specify what are the output and input devices used for speakers when 
toggling between the headset and speakers. 

Note that in order to be able to toggle between headset and speakers during calls, you 
must specify a different device for each.  Using default for both will result in the same 
device being assigned to both so toggling will not work. 

Output Device (Voice Playback) 
Choose a headset, PC-integrated speakers, or external speakers for audio output.  Your 
external playback device is selected by default (if you have one connected). 

Input Device (Voice Recording) 
Choose a headset microphone, PC-integrated microphone, or external microphone for 
voice during calls.  Your external recording device is selected by default (if you have one 
connected).  You can also choose automatic gain control and test your recording device. 

Ring Device (Alert Signal) 
Select the audio device that is played when you receive an incoming call.  If the Alert Info 
service is used, the network may instruct a certain ringing tone to be played. 

Ring Signal 
You can select your own ring signal.  The same signal is used for both voice and video 
calls. 

You can also select an icon to play a tone for incoming messages.  To disable the tone, 
uncheck the icon.  Select a sound event and then click Play to hear the sound. 

24.2.2 Video 

Capture Device (Video) 
Select a camera that you want to use for video calls.  Your external web cam is selected 
by default (if you have one connected). 

Video Size 
Select one of the available sizes.  Note, however, that higher sizes require more 
bandwidth and a more capable central processing unit (CPU). 

Click Test Call to make a test call to test voice quality. 
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24.3 Incoming Calls 
For the list of available call management services for incoming calls, see section  
25 Call Settings.  If the Alert Info service is used, the network may instruct a certain ringing 
tone to be played. 

24.4 Outgoing Calls 
For the list of available call management services for outgoing calls, see section  
25 Call Settings. 

24.5 Voice Mail 
You can specify various voice mail settings, such as which calls are sent to voice mail, 
what kinds of notifications you receive when voice mail arrives as well as controlling how 
fast the voice mail greeting is played and if callers can leave voice mails.  In addition, you 
can control how callers can end up going to voice mail. 

24.6 Services 
In this release, this section is reserved for presence rules and Hub settings. 

24.7 Integrations 
Select how incoming add-in requests are handled, whether they are automatically 
accepted or not or if incoming requests are allowed at all. 

You can also manage extensions using the UC-One Application Programming Interface 
(API), which is used by third-party applications such as the Outlook Add-in or compatible 
headsets.  You can allow such third-party applications to obtain information from UC-One 
and enable or disable confirmation pop-up notifications when third-party applications 
request information from UC-One.  You can also choose default behavior to always reject 
or accept requests from third-party applications and allow or reject individual third-party 
applications. 

The following logic applies for accepting application requests: 

 Every new first-party application can connect without user interaction. 

 Every new third-party application opens a dialog asking for permission to connect.  
Your response is remembered (both negative and positive responses). 

24.8 Advanced 

The Advanced view contains three different subsections: 
 Troubleshooting 

 Proxy 

 Credentials 

Troubleshooting 
Logging is used for troubleshooting.  You may be asked by your service provider to turn 
on logging and then send a log file directory contents.  You can choose basic logging or 
more detailed logging to be enabled.  Detailed logging may consume memory resources, 
so it is not recommended to have it enabled for a long period of time. 

You can also clear the logs and open the logging folder as well as enable and disable 
Google Analytics. 
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Proxy 
Select how to handle HTTP proxies.  By default, the system settings are used but you can 
also choose not to use an HTTP proxy or to use the UC-One (client) proxy settings. 

Credentials 
Credentials section in the Preferences shows your credentials.  If the Login window has an 
embedded configuration URL (see below), the credentials or the configuration URL are 
not visible. 

IM Address 
If XMPP credentials are available to be viewed, they appear here. 

BroadWorks ID 
This is the user name that you use to log in. 
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25 Call Settings 

UC-One supports the following service management features allowing supplementary 
services to be managed using the Preferences and Incoming Calls and Outgoing Calls 
view available in the Main window left pane by selecting the appropriate sub-view in the 
drop-down: 

 Incoming calls 

− BroadWorks Anywhere 

− BroadWorks Remote Office 

− Forward Calls 

− Do Not Disturb 

− Simultaneous Ring Personal 

− Anonymous Call Rejection 

− Call Waiting 

 Voice Messaging 

 Outgoing Calls 

− Block My Number (Calling Line Identification Presentation [CLIP]/Calling Line 
Identification Restriction [CLIR]) 

− Automatic Callback 

− Highlight to call 

− Register to Call 

You can also use the Call Settings with a Main window toolbar on the top of the window, if 
this feature is enabled.  When enabled, this feature allows BroadWorks Anywhere, Do Not 
Disturb, Remote Office, and Call Forwarding to be managed in the Main window using 
single clicks or right clicks.  The Call Settings toolbar is an icon in the left pane with right-
click menus. 

25.1 BroadWorks Anywhere 
BroadWorks Anywhere allows service providers to offer fixed-mobile convergence (FMC) 
services today without additional equipment. 

BroadWorks Anywhere simplifies communications for on-the-go users and remote users 
by extending the features of a desk phone to any other fixed or mobile device, regardless 
of the network or handset manufacturer.  Callers dial one number and can reach you on 
any phone the user chooses.  A desk phone, cell phone, and/or a soft phone may ring 
simultaneously. 

Experience voice call continuity with the ability to move live calls from one device to 
another without hanging up. 

Add locations (numbers) that can be used in the service via the Add Number field.  Use 
the Alert all locations simultaneously check box to activate parallel ringing.  Click on the “+” 
icon to see more options. 

The Don’t divert check box prevents a call from ending up as a voice mail, which can be 
problematic in, for example, conference call situations. 
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Select Answer Confirmation to receive a separate audio prompt when answering a call 
from that number (location).  It may be useful in cases where, for example, mobile 
numbers are being used to prevent incoming calls going to mobile voice mail since the call 
will be ended without going to voice mail if the answer confirmation is not provided. 

Select the Call Control check box to enable the server platform to provide mid-call 
services such as Call Transfer and Conferencing for that number (location). 

25.2 BroadWorks Remote Office 
This service allows the use of any phone as the office phone from a charging and 
numbering perspective.  For instance, a hotel room phone can be used as the office 
phone. 

Enable Remote Office by clicking the service icon and specifying a phone number to be 
used as the Remote Office number. 

25.3 Forward Calls 
Enter a number to which your calls should be forwarded.  Different variants of Call 
Forwarding are supported, such as forwarding always, forwarding when busy, and 
forwarding when you cannot answer or when you are unreachable.  In addition, you can 
specify the number of rings before Call Forwarding is triggered. 

25.4 Do Not Disturb 
When you activate this service, all calls are typically blocked by the server and are sent to 
voice mail.  Enable this service by enabling the service icon. 

25.5 Hide Number 
You can hide or display your number when calling or communicating with other parties or 
contacts.  Hide your number by enabling the service icon.  To show your number, set this 
to “Disable”. 

25.6 Simultaneous Ring Personal 
Add up to ten additional numbers or Session Initiation Protocol Uniform Resource 
Identifier (SIP URI) addresses that you would like to ring in addition to your primary 
number when you receive a call.  In addition, specify whether you want answer 
confirmations and if you would like to receive calls when already on another call.  This 
service is an older variant of BroadWorks Anywhere. 

25.7 Voice Messaging 
You can enable or disable voice messaging in the Preferences and Incoming Calls tab.  
Several settings are available: 

 Send all calls to voice mail. 

 Send busy calls to voice mail. 

 Send unanswered calls to voice mail. 

 Specify how voice mail messages are handled using an indicator in UC-One or 
forwarding to email. 

 Enable notifications of new messages via email. 

 Email a carbon copy of new voice mail. 

 Transfer incoming calls to a specified number using “0” DTMF. 
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 Specify how many rings are used before sending an incoming call to voice mail. 

 Allow/disallow callers to leave a message. 

25.8 Anonymous Call Rejection 
The Anonymous Call Rejection service allows you to reject calls from parties who have 
explicitly restricted their identities. 

You can enable or disable Anonymous Call Rejection in the Preferences and Incoming 
Calls tab. 

25.9 Automatic Callback 
The Automatic Callback (ACB) service allows you to be notified when the previously called 
busy party becomes idle and is connected without having to redial the phone number. 

When you call another party and the call cannot be connected because the line is busy, 
you are prompted to make an Automatic Callback request (for example, “The line you are 
calling is busy.  Press 1 if you would like to be notified when the line becomes available”). 

If you select Automatic Callback, the system monitors the busy party and automatically 
establishes a call when the busy party becomes available. 

You can enable or disable Automatic Callback in the Options (Preferences) and Outgoing 
Calls tab. 

25.10  Call Waiting 
The Call Waiting service allows you to answer a call while already engaged in another call. 

You can enable or disable server-based Call Waiting in the Preferences and Incoming 
Calls tab.  If you disable Call Waiting, the second incoming call is not connected, and the 
caller hears an announcement that the call cannot be completed. 
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26 Sign Out 

Signing out of UC-One sets your status to “Offline” for your contacts and displays the Sign 
In screen. 

26.1 Sign Out of UC-One 
To sign out, follow these steps. 

Windows 
1) Click the UC-One logo in the Main window title bar. 

2) Select Sign Out. 

OS X 
1) Select Actions from the main menu. 

2) Select Sign Out. 

26.2 Exit Application 
To exit the application completely, follow these steps. 

Windows and OS X 
Close the Sign In window. 

Windows 
1) Select the UC-One logo in the Main window title bar. 

2) Click Exit (a keyboard shortcut can also be used). 

OS X 
1) Select UC-One from the main menu. 

2) Select Quit UC-One (a keyboard shortcut can also be used). 

NOTE:  Closing the Main window (not the Sign In window) does not exit the application but 
rather minimizes the application to the system tray (Dock).  This allows you to continue to 
receive calls and messages without having the Contact List window appearing on the desktop. 
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27 Multi-Device Support 

UC-One supports users with multiple devices, according to the XMPP specifications.  This 
is comprised of several features: 

 Chat invitations sent to a user are received on all devices.  Once a particular device 
has been used to answer the chat invitation, subsequent incoming messages only go 
to that device. 

 One can retrieve one’s own presence notifications when another client updates the 
user’s presence.  The client stores this information and updates its own presence so 
that it is the same as the higher priority status it received, (that is, when the received 
status update is manual).  If the received presence update is not manual, it does not 
react to the received update; it only notes it. 

 Last sent and received messages are available on all devices, once synchronization 
is triggered: 

− At login 

− When opening a new tab 

− When presence changes from idle (Away) to any other state 

− When changing presence from offline to any other state 

 Missed chat badges are synchronized across all own devices. 

 A new contact with a new presence subscription made in one client is recognized in 
another. 

 Removing a contact from the contact list in one device is recognized in another client 
and the contact list is updated (that is, the contact is removed) in the other client as 
well. 

If a user has many devices, each device has the same status when shown to the end 
user.  In addition, the contacts on the contact list always see the same status with updates 
shown in the following priority order: 

 Busy 

 Online 

 Away 

 Offline 

This means, for example, that if one client publishes a Busy status and another client 
publishes another status, contacts see the user as Busy.  Compatible devices such as 
desk phones can show presence in the same way. 
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28 Installation 

The installer supports several options on Windows (native Desktop only) as follows, only 
MSI installer is supported: 

 Run when system starts (can be changed later in Preferences). 

 Install Outlook Add-in. 

 Install S4B integration. 

 Change S4B registry values to enable S4B dial pad. 

 Install for all users. 

 Create a desktop icon. 

 Select destination folder for installation. 

 Select the name of the software in the Program menu. 

 Launch the client after installation. 

Agreeing to the license agreement takes place the first time the application is started, as 
on Mac OS.  Note that two clicks are required to accept the EULA due to legal reasons. 

When installer has been run on an end user’s behalf by an administrator, the “Run 
program when system starts” option cannot be changed by that end user. 

If you disable startup, for example, in the Task Manager's Startup list (on Windows 8 and 
10) or from msconfig.exe on Windows 7, the change is not reflected in Preferences.  The 
check box remains checked and grey even though the client is not actually started 
automatically when the system starts. 

You service provider typically has selected an installer language for you.  The default 
language is the language of the operating system; if that cannot be found, English is used 
as the fallback. 

The Outlook Add-in installer is bundled together with the UC-One installer. 

History is specific to the application name.  If upgrading to another UC-One version that 
has a different application name, the history present in the other version is not available. 
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29 Uninstallation 

The uninstallation procedure is different for Windows and OS X. 

29.1 Windows 
Uninstallation is performed by launching the Windows uninstaller via the Start menu or by 
using the Windows “Remove programs” view inside the Control Panel.  Windows 
uninstallation does not require you to select any options.  The language used for the 
Windows Start menu string “Uninstall” is taken from the language chosen when installing 
the client.  This string cannot be changed after installation. 

All files are deleted at uninstallation, except for the following files: 

 Registry entries 

 Account files are only deleted when explicitly allowed by the end user on Windows. 

29.2 OS X 
Uninstalling is performed by simply dragging the application folder from the Applications 
directory to the trash can; however, account files are not deleted.  If you want to remove 
account files, they must be manually deleted.  These are the file locations for the account 
directories.  The following locations apply for all account directories. 

For branded clients: 

/Users/<USERNAME>/Library/Application 
Support/<company_name>/<application_name> 

For the reference client: 

/Users/<USERNAME>/Library/Application Support/BroadSoft/UC-One 
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30 Version Control and Automatic Upgrade 

You may receive a notification to upgrade UC-One to a newer version.  This upgrade 
takes place automatically after you accept it in a separate dialog.  In this release, 
automatic upgrade no longer requires administrator privileges. 

The upgrade may be recommended or mandatory.  If it is mandatory, then UC-One does 
not start before the upgrade is done. 

In the automatic upgrade dialog, you can choose between: 

 Remind Me Later – You will get a new pop-up at next login. 

 Skip This Version – You will not get a new pop-up for this version, but the next or if 
you manually check for updates in the menu. 

 Update Now – Upgrade is done immediately. 
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31 System Requirements 

System requirements are as follows on native Desktop: 

 Operating system:  Mac OS 10.12 Sierra, Mac OS 10.13 High Sierra, Mac OS 10.14 
Mojave, Mac OS 10.15 Catalina, Windows 7 SP1, Windows 8/8.1, or Windows 10 
(Classical view only). 

 The installation footprint is approximately 125 megabytes (MB) on OS X and 215 MB 
on Windows. 

 For voice calls, a sound card, speakers, and a microphone or a headset are required. 

 For video calls, a web cam is required. 

Minimum system requirements for respective operating systems need to be fulfilled, with 
the following additions: 

 A minimum of 2 GB random access memory (RAM) is required. 

 A minimum 1.5 GHz CPU is recommended.  A dual core CPU is recommended for 
video calls at a minimum. 

 Open Graphics Library (OpenGL) 1.5 or higher is recommended. 

For high definition (HD) video, the following is recommended: 

 HD camera 

 HD resolution support in display 

 Quad Core x86 or equivalent at a minimum 

 4 GB RAM 

Virtual Desktop Infrastructure (VDI) environments are not supported. 
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32 Troubleshooting 

Why am I getting a Windows Defender pop-up when launching UC-One? 

Sometimes Windows Defender may report an issue when initially launching applications 
such as UC-One.  In that case, click Allow.  If you do not have administrative permissions 
to your machine, contact your system administrator. 

Why are my Emojis showing as black boxes? 
The Segoe UI font is required for the Emojis to appear correctly.  For more information to 
install the Segoe UI font, see the following article: 

https://support.microsoft.com/en-us/help/4021341/emojis-are-not-displayed-in-office-
applications-in-windows-7 

However, on Windows 7, some Emojis do not work despite this as listed in the following 
table. 

Emoji Number Code 

1 x1f600 

5 x1f615 

7 x1f61B 

9 x1f62E 

11 x1f61F 

15 x1F611 

17 x1F913 

18 x1F634 

19 x1F644 

20 x1F922 
 

Why did I lose chat history after an upgrade to a renamed UC-One? 
When installing a UC-One version that has a different application name, the history is 
specific to that application name.  If the application name remains the same in the 
upgrade, the previous history is available. 

Why can’t I chat with contacts from Yahoo? 
Chatting with users in other domains is possible; however, it depends on the domain.  For 
example, BroadCloud supports Google federation but not Yahoo.  However, group chat is 
not supported in Google federation, so the group chat option with those contacts is shown 
in grey. 

Why can’t I change the avatar? 
Double-clicking the avatar should open a File Explorer view to select a file.  If your XMPP 
connection is lost, changing the avatar fails.  A lost XMPP connection is indicated in the 
Main window’s top notification area. 

https://support.microsoft.com/en-us/help/4021341/emojis-are-not-displayed-in-office-applications-in-windows-7
https://support.microsoft.com/en-us/help/4021341/emojis-are-not-displayed-in-office-applications-in-windows-7


 

UC-ONE FOR DESKTOP USER GUIDE 60-BT9001-00 
©2019 CISCO SYSTEMS, INC. PAGE 79 

My contacts are all offline and my client’s status bar says, “Chat unavailable”.  
What does this mean? 
It means that the XMPP connectivity has been lost for chat, as well as for presence; 
however, you can still make calls.  You should contact your service provider. 

Why am I offline? 
If you have selected “Offline” status, you are shown as offline to others.  Another possibility 
is that you may have lost your Internet connection.  In this case, the client does not log out, 
but rather enters an offline mode where a contact list is available, but communication is 
not possible. 

Why can’t I have more video resolutions available? 
You can choose your video resolution from Preferences and the Audio/Video tab.  Your 
selection is used by default for future video calls.  The available resolutions are 
automatically presented based on your camera. 

Why can’t I change my user name and password? 
User name and password editing is not supported in the client.  To edit your user name or 
password, contact your service provider.  The exception is login password expiry.  When it 
expires, you can change the password in a separate dialog window. 

Why does my all day calendar entry not trigger Busy – In Meeting presence status? 
Not all meetings trigger a presence change to Busy – In Meeting. 

To trigger the presence update, the meeting must be in the Show me as busy state. 

Why aren’t all my group chat messages saved? 
Only the newest chat room messages are stored on the server, but never for My Room for 
security reasons.  Message history feature is enabled, messages sent from other devices 
are also shown. 

Why aren’t all my chat messages available in my other devices? 
All one-on-one and group chat messages are saved, but only locally, so they are not 
necessarily available immediately on your other devices.  Incoming messages are sent to 
all devices; however, the ones that you send are only stored in the device that you are 
using to send the message.  Message history feature is always enabled and, messages 
sent from other devices are also shown when synchronization is triggered 

Why can’t I change the XMPP address of a contact? 
This is not supported in this release.  However, you can delete the contact and add a new 
one. 

Why does my location show an incorrect address? 
It is done based on the public IP address that the machine is using.  The IP address is 
mapped to a physical location.  BroadSoft is working with the mapping provider to improve 
the accuracy of the location.  You can also manually change the location by clicking the 
avatar and changing the location icon. 

Why can’t I start desktop sharing? 
To share your desktop, you need to have valid credentials by using auto-provisioning to 
enable the desktop sharing menu items and icons.  In addition, you need to have the 
service assigned for you.  Contact your service provider if sharing fails.  However, you can 
participate in desktop sharing sessions even without any sharing credentials. 
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I have a USB headset and the Call Control features are not working.  Is there 
anything special I need to do to enable Call Control support? 
To use headsets on Windows (not supported on OS X), several steps are needed: 

1) When the client is started, you must accept the API connection request from the 
connector/add-in device. 

2) If your USB headset uses its own add-in, the standard HID Add-in from BroadSoft 
must be disabled, as both cannot be used at the same time.  In addition, you must 
have “Allow 3rd party extensions” check box checked in Preferences → Extensions 
tab. 

Why is the Outlook Add-in disabled? 

If the context menu does not show Add-in menu items, this could be due to the Outlook 
Add-in disabled by Outlook for slow loading.  This happens primarily in Outlook 2013.  In 
such cases, enable this add-in by selecting the Outlook menu → File → Info → Manage 
Add-Ins → Communication Add-in → Always enable this add-in from the displayed menu 
(as shown in the following figure). 

 
Figure 11  Outlook Account Information – Add-in Disabled 

Why is presence not showing in the Outlook Add-in? 

If the presence indicator icon is not shown in Outlook, verify if any of the following software 
is installed: 

 Microsoft Office Communicator (OCS) 

 Microsoft Lync/S4B  

 Skype version 6.1 or above 

Uninstall each one found and restart Outlook and the UC-One client. 
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NOTE:  During Office/Outlook 2013 installation, the installer installs Microsoft Lync by default.  You 
must uncheck Microsoft Lync (as shown in the following figure) and then proceed with the 
installation. 

 
Figure 12  Microsoft Office Installation Example 

How do I disable/enable the Outlook Add-In from UC-One Preferences view? 
To enable/disable Outlook contact presence status (5.1 Presence in Outlook), from the 
UC-One Preference page, the “UC-One Outlook Add-in, Gateway Process” check box 
option must be checked/unchecked. 

 
Figure 13  UC-One Preference Page 

To enable/disable the Outlook context menu related to the add-in, from the UC-One 
Preference page, the “UC-One Outlook Add-in” check box option must be 
checked/unchecked. 

 
Figure 14  UC-One Preference Page 
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Why are Outlook Add-in IM buttons sometimes are greyed out in the quick contact 
page, even though the user is logged in? 
Sometimes IM buttons are greyed out on the contact page.  When mouse over it, it shows 
the message “To use this feature, sign in to an instant messaging program”. 

 
Figure 15  Outlook Add-in IM Buttons Issue 

This seems to be a Microsoft issue, and the workaround to solve is to restart Outlook. 
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Appendix A:  Keyboard Shortcuts for Desktop 

The following table lists the currently supported keyboard shortcuts (native Desktop only).  
You can use these keyboard shortcuts to quickly perform frequently used actions.  The 
characters used are lower case.  The shortcuts are also indicated in the accessibility 
menus. 

Shortcut for 
Windows 

Shortcut for Mac What it does 

CTRL-Q Cmd-Q This quits the application. 

Alt+F4 Cmd-W This closes the selected window (except for a contact card and 
the About window). 

CTRL+C Cmd-C This copies selected text from Communicator to the clipboard. 

CTRL+V Cmd-V This pastes text from the clipboard to the location selected using 
the cursor in Communicator. 

CTRL-X Cmd-X This cuts the selected text to clipboard. 

Enter Enter When in the Communications window, this sends a chat 
message (if the Chat view is visible). 
When in the contact list, this opens a chat with the selected 
contact. 
When in the Communications History, this opens a 
communications session with the contact or address related to 
the selected item.  This opens a chat if the item was chat and a 
call if the item was a call. 

-, Cmd-, This opens Preferences. 

F1 Cmd-? This opens Help. 

CTRL+A Cmd-A This selects all text in the Chat view. 

- Cmd-H This hides Communicator. 

- Alt-Cmd-H This hides other windows other than Communicator. 

CTRL-N Cmd-N This opens the Add Contact window. 

Shift-CTRL-N Shift-Cmd-N This opens the Add Group window. 

CTRL -1 Cmd-1 When a contact is selected, this opens a chat session with the 
contact. 

CTRL -2 Cmd-2 When a contact is selected, this calls the contact with audio. 

CTRL -3 Cmd-3 When a contact is selected, this calls the contact using call from 
phone. 

CTRL -4 Cmd-4 When a contact is selected, this calls the contact with video. 

CTRL -5 Cmd-5 When a contact is selected, this joins their room. 

CTRL -6 Cmd-6 When a contact is selected, this opens an email-sending window 
using the default email client. 

CTRL -I Cmd-I When a contact is selected, this opens the contact card for the 
contact. 

Shift-CTRL-F Shift-Cmd-F When a contact is selected, this makes the contact a favorite. 

CTRL-delete Cmd-delete This deletes the selected contact. 

CTRL-arrow down Cmd-arrow down This decreases the volume. 
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Shortcut for 
Windows 

Shortcut for Mac What it does 

CTRL-arrow up Cmd-arrow up This increases the volume. 

CTRL-space CTRL-space This mutes the client (while in a call). 

CTRL-D Cmd-D This turns on the Do Not Disturb service. 

CTRL-P Cmd-P This pulls an ongoing call from your other device to 
Communicator. 

Alt-shift- CTRL-P Alt-shift-Cmd-P This retrieves your parked call. 

- Alt-Cmd-2 This calls your voice mail with audio. 

- Alt-Cmd-3 This calls your voice mail with audio using call from phone. 

- Alt-Cmd-4 This calls your voice mail with video. 

Shift-CTRL-R Shift-Cmd-R This opens your My Room. 

CTRL-M Cmd-M This minimizes the window on Mac OS.  On Windows, it only is 
used for the Team Telephony window. 

CTRL-T Cmd-T This enables always on top. 

- Shift-Cmd-M This opens the Main window. 

Shift-CTRL-C Shift-Cmd-C This opens contacts. 

Shift-CTRL-F2 Shift-Cmd-F2 This opens call history. 

Shift-CTRL-F1 Shift-Cmd-F1 This opens chat history. 

Shift-CTRL-F3 Shift-Cmd-F3 This opens visual voice mail. 

Shift-CTRL-D Shift-Cmd-D This opens the dial pad view. 

Shift-CTRL-W Shift-Cmd-W This opens the web button view. 

Shift-CTRL-O Cmd-O This causes Communicator to logout. 

Ctrl-7 Cmd-7 This answers an incoming call with audio. 

Ctrl-8 Cmd-8 This answers an incoming call with video. 

Ctrl-9 Cmd-9 This declines an incoming call. 
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Appendix B:  Guest Client Usage 

This section provides more hands-on information about guest client usage. 

1) Right-click on the My Room icon to copy the guest join link and send it to a guest via 
email or other means.  You can also use the Meeting Info space in My Room to copy 
the guest user invitation. 

 
Figure 16  Copy Guest Join Link Menu Option 

2) The guest can open the link in one of the supported browsers, enter their name and 
password, and then click Join Room.  If the Meet app has not yet been downloaded, 
then it must be downloaded for the join procedure to continue. 

 
Figure 17  Login Screen for Join Room 

The guest must click on one more link to be able to join the My Room session. 

 
Figure 18  Deep Link for Join Room 
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3) The guest is allowed into your room once the room owner has entered the room and 
can now participate in the call and multi-user chat with other participants in the room 
(as shown in the following figure). 

 
Figure 19  My Room Window – Guest Chat 

The guest can join the video portion of the session by clicking on the video button. 

The guest can switch between audio and video mode by clicking on the video icon.  
They can also mute and end the call by clicking on the mute and end call icons 
respectively. 

The guest can show or hide their self-view by clicking on the video icons in the bottom 
part of the Meet window. 

4) You can start your desktop share from the Desktop client and the guest then sees it.  
The video call is resized and moved to the bottom row. 
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Figure 20  My Room – Desktop Share with Video Call 
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Appendix C:  Skype for Business Integration 

This section provides more hands-on information about Skype for Business (S4B) 
integration usage. 

The typical startup procedure is as follows (reversing the order in which S4B and 
Communicator are started is also supported): 

1) Start S4B. 

2) Start Communicator.  You can have it minimized or in the foreground although 
minimizing is recommended.  Your service provider may also choose an automatic 
“Minimize after login” feature that automatically minimizes Communicator after login. 

By default, when making a PSTN call from S4B while UC-One is minimized, UC-One 
comes to the foreground for the duration the call and is then auto-minimized after call 
except in the following cases: 

 Chat has been used during the call (chat may continue) 

 Window size has been changed 

 Active view has been changed (for example, from contacts to dial pad) 

UC-One does not minimize after an incoming PSTN call to UC-One unless configured to 
do so by your service provider.  In addition, by default, if UC-One is in the task bar before 
the call, then it does not auto-minimize. 

When auto-minimizing after call is enabled by your service provider, Communicator is sent 
to the background “closed”, so that you can only access it through the system tray.  If 
Communicator is either minimized or in the background when a call is triggered outside of 
Communicator, or a call is answered with Communicator, upon terminating the last call, 
Communicator is sent to the background. 

All other communications related to that call, such as chat, are terminated and the 
tab/communications window is closed prior to sending Communicator to the background.  
This happens regardless if you are engaged in ongoing chats, share, or other activities 
inside or outside the last call that terminated. 

If Communicator is brought to the foreground manually this behavior does not apply. 

The original intended use case for S4B integration was to use S4B for presence and chat 
and on-net (VoIP) calls while Communicator would be used for off-net calls with presence 
and chat turned off.  However, many deployments keep the full presence and chat 
functionality of Communicator.  Communicator supports presence synchronization 
between S4B and Communicator for most presence statuses. 

The following sections describe the ways to make various kinds of calls. 

On-Net Calling 
To make an on-net call: 

1) Select a S4B contact and click the call button.  Alternatively, right-click a contact and 
select an on-net number. 

2) Both the S4B main window and communications window are visible (as shown in the 
following figures). 
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Figure 21  Making an On-Net Call 

 
Figure 22  Ongoing On-Net Call 

Off-Net Calling 
Off-net calling must be done using a custom menu “Call with <application name>”. 

Your service provider can configure Communicator to make the call instead of S4B in 
these cases. 

To make an off-net call: 

1) Select a contact, right-click and select “Call with <application name>” menu.  Use the 
submenu to select the desired number. 
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2) Communicator attempts to make the call instead of S4B.  Both the S4B main window 
and Communicator Communications window are visible. 

 
Figure 23  Making an Off-Net Call 

 
Figure 24  Ongoing Off-Net Call 

After the call, UC-One typically is minimized unless there is, for example, chat ongoing. 

Presence Synchronization 
When Communicator is configured to have full presence functionality and to also act in 
S4B integration mode, making a call in Communicator may automatically change 
Communicator presence to Busy –In Call.  In this case, a similar presence status is 
automatically selected on the S4B side and vice versa. 
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The same principle also applies to other presence statuses.  Changing presence on the 
S4B side is detected by Communicator and a similar presence state is automatically 
shown on the Communicator side.  Note that the different presence statuses used in S4B 
and Communicator are not 100% the same so an exact mapping is not possible.  
However, a status variant is matched to a similar status variant on the other client.  For 
example, a busy status variant would be matched to a busy status variant. 
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Appendix D:  Configure USB Headsets 

This section provides more information on configuring USB devices to function with UC-
One.  Note that some headset manufacturers have built their own add-ins for UC-One, for 
instance, Jabra on Windows.  In this case, the standard HID Add-Ins cannot be used at 
the same time.  You can enable and disable add-ins in the Preferences → Extensions 
view. 

In general on Windows, if “Default Communication Device” is defined in Windows settings, 
it is selected over the “Default Device” by UC-One for calls when several audio devices 
are available (for example, USB headset and the integrated audio device on the PC).  
However, when using headsets, you can select a separate device than the headset for 
alerting incoming calls. 

The following examples provide more information on how to define a default 
communications device when a USB headset is available on the PC. 

It is recommended to select “Use Default” in the Media tab of UC-One Preferences for 
both input and output devices (as shown in the following figure). 

 
Figure 25  Preferences Window 
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1) To define the default communications device, make sure that the Sound settings in 
Windows pertaining to “Recording” and “Playback” devices are correctly configured.  
From the Sound applet, select the Playback tab. 

 
Figure 26  Sound Window – Playback Tab 

In this example, the user has a Plantronics BT300M (the USB dongle accompanying a 
Voyager Legend UC) connected to their PC. 
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2) Click Headset Earphone to highlight the device and click on the drop-down arrow 
next to the Set Default button. 

 
Figure 27  Sound Window – Playback Tab – Set Default 
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3) Select Default Communication Device.  The following screen is displayed. 

 
Figure 28  Sound Window – Playback Tab – Default Set 
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4) Next, click the Recording tab. 

 
Figure 29  Sound Window – Recording Tab 
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5) Again, click on Headset Microphone, which represents the connected Plantronics 
BT300M device, and click on the drop-down arrow next to the Set Default button. 

 
Figure 30  Sound Window – Recording Tab – Set Default 
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6) Select Default Communication Device. 

 
Figure 31  Sound Window – Recording Tab – Default Set 

7) Click OK to save the changes.  The Sound window is dismissed, and your device is 
now ready to be used by UC-One. 
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Appendix E:  Third-Party Software and Copyright 

The list of third-party software is used in UC-One is available behind the following link: 

https://www.cisco.com/c/en/us/about/legal/open-source-documentation-
responsive.html?flt0_general-table0=UC-One 

https://www.cisco.com/c/en/us/about/legal/open-source-documentation-responsive.html?flt0_general-table0=UC-One
https://www.cisco.com/c/en/us/about/legal/open-source-documentation-responsive.html?flt0_general-table0=UC-One
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Appendix F:  Acronyms and Abbreviations 

This section lists the acronyms and abbreviations found in this document.  The acronyms 
and abbreviations are listed in alphabetical order along with their meanings. 

ACB  Automatic Callback 

API   Application Programming Interface 

CPU  Central Processing Unit 

DTMF  Dual-Tone Multi-Frequency 

ECACS  Emergency Call Address Change Service 

EULA  End-User License Agreement 

FAC  Feature Access Code 

FAQ  Frequently Asked Question 

FMC  Fixed-mobile Convergence 

GUI   Graphical User Interface 

GW   Gateway 

HD   High Definition 

HID   Human Interface Device 

IM   Instant Message 

IM&P  Instant Messaging and Presence 

IP   Internet Protocol 

LDAP  Lightweight Directory Access Protocol 

LGPL  Lesser General Public License 

OpenGL   Open Graphics Library 

PIV   Personal Identity Verification 

PSTN  Public Switched Telephone Network 

RAM  Random Access Memory 

S4B  Skype for Business 

SaaS  Software as a Service 

SIP   Session Initiation Protocol 

SSL  Secure Sockets Layer 

SSO  Single Sign-On 

UC   Unified Communications 

UI   User Interface 

URL  Uniform Resource Locator 

VDI   Virtual Desktop Infrastructure 

VoIP  Voice over IP 

VVM  Visual Voice Mail 
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WebRTC  Web Real-Time Communication 

XMPP  Extensible Messaging and Presence Protocol 

Xsi   Xtended Services Interface 
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